SIEMENS

SIMATIC

Engineering Tools
S7-PLCSIM V14 online help

Programming and Operating Manual

Security information 1
S7-PLCSIM overview 2
Startup options 3
Modifying a running simulation 4
Working in Compact view 5
Working in Project view 6
Simulating communication 7
Error conditions and limitations 8
Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

**DANGER**
indicates that death or severe personal injury **will** result if proper precautions are not taken.

**WARNING**
indicates that death or severe personal injury **may** result if proper precautions are not taken.

**CAUTION**
indicates that minor personal injury can result if proper precautions are not taken.

**NOTICE**
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

**WARNING**

Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Table of contents

1 Security information ................................................................................................................................................................. 9

2 S7-PLCSIM overview ........................................................................................................................................................................ 11
   2.1 Introduction to S7-PLCSIM ................................................................................................................................................. 11
   2.2 What's new in S7-PLCSIM V14? ........................................................................................................................................... 11
   2.3 Input values .............................................................................................................................................................................. 12
   2.4 Installation setup, requirements, repair, and uninstallation ................................................................................................. 12
      2.4.1 Important note about simulating S7-300 and S7-400 PLCs ........................................................................................... 12
      2.4.2 Requirements for S7-PLCSIM installation ....................................................................................................................... 13
      2.4.3 S7-PLCSIM installation setup ....................................................................................................................................... 13
      2.4.4 Repairing and uninstalling S7-PLCSIM ............................................................................................................................ 13
   2.5 Differences between S7-PLCSIM products .......................................................................................................................... 14
   2.6 Supported hardware ............................................................................................................................................................... 14
      2.6.1 Hardware support based on STEP 7 license ....................................................................................................................... 14
      2.6.2 Steps for recognizing hardware with upgraded firmware ................................................................................................. 15
   2.7 S7-PLCSIM concepts .............................................................................................................................................................. 15
      2.7.1 Starting to work in S7-PLCSIM ....................................................................................................................................... 15
      2.7.2 Compact view and Project view ....................................................................................................................................... 16
         2.7.2.1 Starting in Project view vs. Compact view ................................................................................................................... 16
         2.7.2.2 Switching between Compact view and Project view ................................................................................................ 16
      2.7.3 Separation of simulations and projects ............................................................................................................................ 17
      2.7.4 Starting and stopping a simulation .................................................................................................................................. 17
         2.7.4.1 Starting and stopping a simulation ......................................................................................................................... 17
         2.7.4.2 Simulation and the power button ............................................................................................................................ 19
      2.7.5 Simulation states ............................................................................................................................................................... 21
      2.7.6 Supported STEP 7 programs for simulation ..................................................................................................................... 22
      2.7.7 RUN and STOP modes and simulation ............................................................................................................................ 23
      2.7.8 Differences between a simulated PLC and a "real" PLC ................................................................................................. 23
         2.7.8.1 Overview of differences ........................................................................................................................................ 23
         2.7.8.2 Differences common to all supported PLCs ................................................................................................................. 23
         2.7.8.3 Differences specific to S7-1200 PLCs .......................................................................................................................... 27
         2.7.8.4 Differences specific to S7-1500 PLCs .......................................................................................................................... 28
         2.7.8.5 Differences specific to ET 200SP PLCs .......................................................................................................................... 31
   2.8 Using the help system .............................................................................................................................................................. 33
      2.8.1 Overview of the help system ........................................................................................................................................ 33
      2.8.2 Searching the help system .......................................................................................................................................... 35
      2.8.3 Readme and Online Readme files .................................................................................................................................. 35
# Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td><strong>Startup options</strong></td>
<td>37</td>
</tr>
<tr>
<td>3.1</td>
<td>Overview of startup options</td>
<td>37</td>
</tr>
<tr>
<td>3.2</td>
<td>Startup from TIA Portal</td>
<td>37</td>
</tr>
<tr>
<td>3.2.1</td>
<td>Overview of startup from the TIA Portal</td>
<td>37</td>
</tr>
<tr>
<td>3.2.2</td>
<td>Using the Start simulation command</td>
<td>37</td>
</tr>
<tr>
<td>3.2.3</td>
<td>Launching in Compact view with the Start simulation command</td>
<td>38</td>
</tr>
<tr>
<td>3.2.4</td>
<td>Launching in Project view with the Start simulation command</td>
<td>38</td>
</tr>
<tr>
<td>3.3</td>
<td>Startup from desktop icon or start menu</td>
<td>38</td>
</tr>
<tr>
<td>3.3.1</td>
<td>Overview of starting from a desktop icon or start menu</td>
<td>38</td>
</tr>
<tr>
<td>3.4</td>
<td>Startup from an existing S7-PLCSIM project</td>
<td>39</td>
</tr>
<tr>
<td>3.4.1</td>
<td>Overview of startup from an existing project</td>
<td>39</td>
</tr>
<tr>
<td>3.4.2</td>
<td>Open a project by double-clicking the file name</td>
<td>39</td>
</tr>
<tr>
<td>3.4.3</td>
<td>Open project from main menu &quot;Project&quot; and main toolbar</td>
<td>39</td>
</tr>
<tr>
<td>3.4.4</td>
<td>Opening an S7-PLCSIM V13 SP1 project</td>
<td>39</td>
</tr>
<tr>
<td>3.4.5</td>
<td>Opening a project created prior to V13 SP1</td>
<td>40</td>
</tr>
<tr>
<td>3.4.6</td>
<td>Using an existing S7-PLCSIM project for simulation and debugging</td>
<td>40</td>
</tr>
<tr>
<td>4</td>
<td><strong>Modifying a running simulation</strong></td>
<td>41</td>
</tr>
<tr>
<td>4.1</td>
<td>Overview of modifying a running simulation</td>
<td>41</td>
</tr>
<tr>
<td>4.2</td>
<td>Simulating a power cycle</td>
<td>42</td>
</tr>
<tr>
<td>4.3</td>
<td>Changing the CPU family being simulated</td>
<td>43</td>
</tr>
<tr>
<td>4.4</td>
<td>Configured versus unconfigured simulations</td>
<td>44</td>
</tr>
<tr>
<td>5</td>
<td><strong>Working in Compact view</strong></td>
<td>45</td>
</tr>
<tr>
<td>5.1</td>
<td>Overview of working in Compact view</td>
<td>45</td>
</tr>
<tr>
<td>5.2</td>
<td>Compact view user interface</td>
<td>46</td>
</tr>
<tr>
<td>5.3</td>
<td>Using memory reset (MRES) in Compact view</td>
<td>48</td>
</tr>
<tr>
<td>6</td>
<td><strong>Working in Project view</strong></td>
<td>49</td>
</tr>
<tr>
<td>6.1</td>
<td>Project view user interface</td>
<td>49</td>
</tr>
<tr>
<td>6.1.1</td>
<td>Project view user interface overview</td>
<td>49</td>
</tr>
<tr>
<td>6.1.2</td>
<td>The S7-PLCSIM menu bar</td>
<td>50</td>
</tr>
<tr>
<td>6.1.2.1</td>
<td>S7-PLCSIM menu bar</td>
<td>50</td>
</tr>
<tr>
<td>6.1.2.2</td>
<td>S7-PLCSIM menu bar commands</td>
<td>51</td>
</tr>
<tr>
<td>6.1.3</td>
<td>The S7-PLCSIM toolbar</td>
<td>58</td>
</tr>
<tr>
<td>6.1.3.1</td>
<td>S7-PLCSIM toolbar</td>
<td>58</td>
</tr>
<tr>
<td>6.1.3.2</td>
<td>S7-PLCSIM toolbar objects</td>
<td>59</td>
</tr>
<tr>
<td>6.1.4</td>
<td>Project tree description</td>
<td>62</td>
</tr>
<tr>
<td>6.1.5</td>
<td>Application settings</td>
<td>63</td>
</tr>
<tr>
<td>6.1.5.1</td>
<td>Overview of settings</td>
<td>63</td>
</tr>
<tr>
<td>6.1.5.2</td>
<td>Application settings</td>
<td>64</td>
</tr>
<tr>
<td>6.1.5.3</td>
<td>Start view</td>
<td>64</td>
</tr>
<tr>
<td>6.1.5.4</td>
<td>Reset to default</td>
<td>64</td>
</tr>
<tr>
<td>6.1.5.5</td>
<td>Storage settings</td>
<td>65</td>
</tr>
<tr>
<td>6.1.5.6</td>
<td>Cycle time settings</td>
<td>65</td>
</tr>
<tr>
<td>6.1.5.7</td>
<td>Undo/redo in application settings</td>
<td>65</td>
</tr>
<tr>
<td>6.1.6</td>
<td>Managing the workspace</td>
<td>66</td>
</tr>
<tr>
<td>6.1.7</td>
<td>Keyboard shortcuts</td>
<td>67</td>
</tr>
</tbody>
</table>
# Table of contents

6.2 Using Undo and Redo in Project view .......................................................... 69
6.2.1 Overview of Undo and Redo ................................................................. 69
6.2.2 Clearing the Undo/Redo queue ............................................................ 69
6.2.3 Interaction between Undo and Redo .................................................... 70
6.2.4 Undo and Redo in the main Project view window .................................. 71
6.2.5 Undo and Redo under Project view main menu > Options > Settings .... 73

6.3 Working with projects ................................................................................. 73

6.4 Project view: simulation and project states ............................................... 75
6.4.1 Simulations and projects are separate actions ..................................... 75
6.4.2 Overview of project and simulation states ......................................... 75
6.4.3 No open project and no running simulation ..................................... 76
6.4.4 No open project and a running but unconfigured simulation ............ 77
6.4.5 No open project with a configured simulation .................................. 78
6.4.6 Project is open with no running simulation ...................................... 79
6.4.7 Project is open with a running but unconfigured simulation ............. 80
6.4.8 Project is open with a running, configured simulation ...................... 81

6.5 Visual feedback regarding online and offline states ................................. 81

6.6 Working in Device configuration view ....................................................... 82
6.6.1 Overview of Device configuration view .............................................. 82
6.6.2 Device configuration user interface .................................................... 82
6.6.3 Device configuration sections ............................................................ 84
6.6.3.1 Configured hardware section ....................................................... 84
6.6.3.2 Addresses section .......................................................................... 86
6.6.4 Undo and Redo in Device configuration ............................................ 86
6.6.5 Device configuration view before a STEP 7 download ....................... 87
6.6.6 Device configuration view after a STEP 7 download ......................... 87

6.7 Features common to both SIM table and Sequence editors ...................... 88
6.7.1 Overview of common features ............................................................ 88
6.7.2 Common clipboard actions ............................................................... 88
6.7.3 Adding, editing, and deleting rows ..................................................... 89
6.7.4 Applying tags for addresses ............................................................... 89
6.7.5 Auto-completion for tags ................................................................... 89
6.7.6 Common row indicators ..................................................................... 91
6.7.6.1 Overview of the common row indicators ...................................... 91
6.7.6.2 Error indicator ............................................................................... 91
6.7.6.3 Force indicator ............................................................................... 91
6.7.6.4 Fail-safe indicator .......................................................................... 91

6.8 Working in the SIM table editor ............................................................... 92
6.8.1 SIM table editor description ............................................................. 92
6.8.2 Overview of working in the SIM table editor ..................................... 94
6.8.3 Undo and Redo in the SIM table editor ............................................. 95
6.8.4 Creating and populating a SIM table ................................................ 95
6.8.4.1 Overview of creating and populating a SIM table ......................... 95
6.8.4.2 SIM table: load project tags from STEP 7 ..................................... 95
6.8.4.3 Using auto fill in the SIM table .................................................... 95
6.8.4.4 SIM table: copy and paste tags and tables from STEP 7 ............... 96
6.8.4.5 SIM table: import and export using Microsoft Excel ..................... 97
6.8.4.6 Drag and drop a module from Device configuration to create a SIM table .................. 98
6.8.5 Monitoring and modifying SIM table values ....................................... 99
# Table of contents

6.8.6 Creating a new sequence from recorded SIM table editor actions .................................................. 100
6.8.7 SIM table error conditions ........................................................................................................ 101
6.9 Working in the Sequence editor ................................................................................................ 102
6.9.1 Overview of working in the Sequence editor ............................................................................ 102
6.9.2 Sequence editor description .................................................................................................. 103
6.9.3 Undo and Redo in the Sequence editor .................................................................................... 106
6.9.4 Creating and populating a sequence ........................................................................................ 107
6.9.4.1 Overview of creating and populating a sequence ................................................................. 107
6.9.4.2 Working with a sequence created from a SIM table recording ........................................... 107
6.9.4.3 Sequence: using auto fill ..................................................................................................... 108
6.9.4.4 Sequence: copy and paste tags and tables from STEP 7 .................................................... 108
6.9.4.5 Sequence: import and export using Microsoft Excel ............................................................ 109
6.9.4.6 Sequence: import from a STEP 7 trace ................................................................................ 110
6.9.4.7 Recording a sequence from SIM table actions ...................................................................... 114
6.9.4.8 Methods for starting a sequence ............................................................................................ 115
6.9.4.9 Sequence start action ............................................................................................................ 115
6.9.4.10 Repeating a sequence from the toolbar button .................................................................... 116
6.9.4.11 Start a sequence with a trigger condition ........................................................................... 117
6.9.4.12 Repeating a sequence configured to trigger from a tag ........................................................ 119
6.9.4.13 Visual feedback while running a sequence ........................................................................ 120
6.9.4.14 Sequence actions and action parameters .......................................................................... 121
6.9.4.15 Time-related Sequence information ..................................................................................... 121
6.9.4.16 Sequence time entry ............................................................................................................ 121
6.9.4.17 Sequence step timing .......................................................................................................... 123
6.9.4.18 Edit execution time .............................................................................................................. 124
6.9.4.19 Inserting, adding, and deleting sequence steps .................................................................. 126
6.9.4.20 Enable and disable sequence steps ...................................................................................... 127
6.9.4.21 Step time adjustment ......................................................................................................... 128
6.9.4.22 Running more than one sequence at a time ....................................................................... 129
6.9.4.23 Sequence error conditions .................................................................................................. 129
6.9.5 Methods for starting a sequence ............................................................................................... 137
6.9.5.1 Sequence start action ............................................................................................................ 137
6.9.5.2 Repeating a sequence from the toolbar button .................................................................... 137
6.9.5.3 Start a sequence with a trigger condition ........................................................................... 138
6.9.5.4 Repeating a sequence configured to trigger from a tag ........................................................ 138
6.9.5.5 Visual feedback while running a sequence ........................................................................ 138
6.9.5.6 Sequence actions and action parameters .......................................................................... 138
6.9.5.7 Time-related Sequence information ..................................................................................... 138
6.9.5.8 Sequence time entry ............................................................................................................ 138
6.9.5.9 Sequence step timing .......................................................................................................... 138
6.9.5.10 Edit execution time ............................................................................................................. 138
6.9.5.11 Inserting, adding, and deleting sequence steps .................................................................. 138
6.9.5.12 Enable and disable sequence steps ...................................................................................... 138
6.9.5.13 Step time adjustment ......................................................................................................... 139
6.9.5.14 Running more than one sequence at a time ....................................................................... 139
6.9.5.15 Sequence error conditions .................................................................................................. 139
6.9.6 Recording a sequence from SIM table actions ........................................................................ 140
6.9.7 Methods for starting a sequence ............................................................................................... 140
6.9.7.1 Sequence time entry ............................................................................................................ 140
6.9.7.2 Sequence step timing .......................................................................................................... 140
6.9.7.3 Edit execution time .............................................................................................................. 140
6.9.7.4 Inserting, adding, and deleting sequence steps .................................................................. 140
6.9.7.5 Enable and disable sequence steps ...................................................................................... 140
6.9.7.6 Step time adjustment ......................................................................................................... 140
6.9.7.7 Running more than one sequence at a time ....................................................................... 140
6.9.7.8 Sequence error conditions .................................................................................................. 140

7 Simulating communication ............................................................................................................. 131
7.1 Overview of simulating communication ....................................................................................... 131
7.2 Running multiple concurrent simulations ...................................................................................... 132
7.3 Supported communication instructions between PLC families .................................................. 133

8 Error conditions and limitations ..................................................................................................... 137
8.1 Overview ....................................................................................................................................... 137
8.2 Specific error conditions and limitations ....................................................................................... 137
8.2.1 Compile error after attempting to download to S7-PLCSIM .................................................... 137
8.2.2 HMI Accessible tags ................................................................................................................. 137
8.2.3 Errors when simulating communication for multiple unconfigured CPUs .......................... 137
8.2.4 "Cut" performs a "Copy" between S7-PLCSIM instances ....................................................... 138
8.2.5 Simulating communication with an HMI and multiple PLCs ................................................. 138
8.2.6 Avoid forcing inputs when simulating S7-1500 ...................................................................... 138
8.2.7 Wait briefly after going to RUN mode to access motion control technology objects .......... 139
8.2.8 Simulating Fail-safe programs ................................................................................................. 139
8.2.9 Use STEP 7 safety system library v1.3 or later for Fail-safe I/O ............................................. 139
8.2.10 Working with global libraries ................................................................................................. 140
8.2.11 Valid range for Sequence "Set to frequency" values ............................................................. 140

S7-PLCSIM V14 online help

Programming and Operating Manual, V14, 09/2016, A5E38930186-AA
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.2.12</td>
<td>Incorrect RET_VAL parameter values for S7-1500 EN_AIRT and DIS_AIRT instructions that are called from multiple OBs</td>
</tr>
<tr>
<td>8.2.13</td>
<td>Cyclic event overflow error</td>
</tr>
<tr>
<td>8.2.14</td>
<td>Password protection levels and simulation</td>
</tr>
<tr>
<td>8.2.15</td>
<td>STEP 7 online &amp; diagnostics functions</td>
</tr>
<tr>
<td>8.2.16</td>
<td>Simulation during standby mode</td>
</tr>
<tr>
<td>8.2.17</td>
<td>Running S7-PLCSIM on a remote desktop connection</td>
</tr>
<tr>
<td>8.2.18</td>
<td>Working with automatically synchronized network drives</td>
</tr>
<tr>
<td>8.2.19</td>
<td>Project menu delay</td>
</tr>
<tr>
<td>8.2.20</td>
<td>Mnemonics selection</td>
</tr>
</tbody>
</table>

Index | 145 |
Siemens provides products and solutions with industrial security functions that support the secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. Siemens’ products and solutions only form one element of such a concept.

Customer is responsible to prevent unauthorized access to its plants, systems, machines and networks. Systems, machines and components should only be connected to the enterprise network or the internet if and to the extent necessary and with appropriate security measures (e.g. use of firewalls and network segmentation) in place.


Siemens’ products and solutions undergo continuous development to make them more secure. Siemens strongly recommends to apply product updates as soon as available and to always use the latest product versions. Use of product versions that are no longer supported, and failure to apply latest updates may increase customer’s exposure to cyber threats.

2.1 Introduction to S7-PLCSIM

The focus of S7-PLCSIM is to support debugging and validating a single PLC program without requiring actual hardware. S7-PLCSIM allows you to use all STEP 7 debugging tools, including, for example, the watch table, program status, and online & diagnostics functions. S7-PLCSIM also provides tools that are unique to S7-PLCSIM, including a SIM table and sequence editor.

S7-PLCSIM operates in conjunction with STEP 7 in the TIA Portal. You can configure your PLC and any associated modules in STEP 7, program your application logic, and then download the hardware configuration and program to S7-PLCSIM in either Compact view or Project view.

See also

Siemens Industry Online Support (https://support.industry.siemens.com/cs/?lc=en-US)

2.2 What's new in S7-PLCSIM V14?

New features in S7-PLCSIM V14

S7-PLCSIM V14 contains many useful new features and functions, including the following:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separation of project and simulation:</td>
<td>Overview of project and simulation states (Page 75)</td>
</tr>
<tr>
<td>Simulation states: none, unconfigured, configured</td>
<td>Simulation states (Page 21)</td>
</tr>
<tr>
<td>Start and stop a simulation using new power button</td>
<td>Simulating a power cycle (Page 42)</td>
</tr>
<tr>
<td>Compact view: changes in user interface and functionality</td>
<td>Overview of working in Compact view (Page 45)</td>
</tr>
<tr>
<td>Support for additional hardware:</td>
<td>Hardware support based on STEP 7 license (Page 14)</td>
</tr>
<tr>
<td>S7-1200 Fail-safe devices</td>
<td></td>
</tr>
<tr>
<td>S7-1500T</td>
<td></td>
</tr>
<tr>
<td>Support for communication in an S7-1200 simulation</td>
<td>Overview of simulating communication (Page 131)</td>
</tr>
<tr>
<td>Support for communication between S7-1500, S7-1200, S7-300, and S7-400 CPUs</td>
<td>Overview of simulating communication (Page 131)</td>
</tr>
<tr>
<td>Undo and Redo toolbar buttons</td>
<td>Overview of Undo and Redo (Page 69)</td>
</tr>
<tr>
<td>Device configuration view: display of distributed I/O devices</td>
<td>Downloaded central and decentral hardware display (Page 84)</td>
</tr>
</tbody>
</table>
2.3 Input values

Input area values from the S7-PLCSIM Project view SIM table editor and sequence editor are equivalent to physical inputs on a "real" CPU. These are the values that will be copied to the process image at the start of each scan cycle.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag and drop a module to create a SIM table</td>
<td>Drag and drop a module from Device configuration view to create a SIM table (Page 98)</td>
</tr>
<tr>
<td>Sequence editor: edit execution time</td>
<td>Edit execution time (Page 124)</td>
</tr>
<tr>
<td>Sequence editor: enable and disable sequence steps</td>
<td>Enable and disable sequence steps (Page 127)</td>
</tr>
<tr>
<td>Sequence editor: repeat sequence from new toolbar button</td>
<td>Repeating a sequence from the toolbar button (Page 116)</td>
</tr>
<tr>
<td>Sequence editor: delay multiple steps in one action</td>
<td>Step time adjustment (Page 128)</td>
</tr>
<tr>
<td>Sequence editor: create a sequence from an imported STEP 7 trace measurement</td>
<td>Import a STEP 7 trace to create a sequence (Page 111)</td>
</tr>
<tr>
<td>Sequence editor: start a sequence with a trigger condition</td>
<td>Start a sequence with a trigger condition (Page 117)</td>
</tr>
</tbody>
</table>

2.4 Installation setup, requirements, repair, and uninstallation

2.4.1 Important note about simulating S7-300 and S7-400 PLCs

Previously, S7-PLCSIM V5.4.x installed automatically with TIA Portal. That is no longer the case.

If you want to simulate S7-300 and S7-400 PLCs using TIA Portal V14, you must first install S7-PLCSIM V14. Installing S7-PLCSIM V14 automatically upgrades your existing S7-PLCSIM V14 V5.4.6 or lower to S7-PLCSIM V5.4.7.
2.4.2 Requirements for S7-PLCSIM installation

You must meet the following requirements before you install S7-PLCSIM V14.

Use a supported operating system

S7-PLCSIM V14 supports the same set of operating systems as the TIA Portal V14. Refer to the Readme section of the TIA Portal online help for the definitive list of supported operating systems.

If you have already installed TIA Portal V14 successfully, S7-PLCSIM V14 should also install correctly.

2.4.3 S7-PLCSIM installation setup

S7-PLCSIM has its own setup independent of the TIA Portal.

S7-PLCSIM must be installed manually. It is not automatically installed as part of the TIA Portal setup process.

Multiple versions of S7-PLCSIM can be installed on the same PG/PC without interference. This is the same behavior as the TIA Portal, where multiple versions of the software (V13 and V14 for example) can be installed on the same PG/PC.

Interaction with the TIA Portal

During installation, the setup process registers S7-PLCSIM with the TIA Portal to support simulation for specific PLC families. There are no actions you need to take to enable registration.

Once S7-PLCSIM is installed, the main menu commands and toolbar buttons become enabled when a supported device has the application focus.

2.4.4 Repairing and uninstalling S7-PLCSIM

Since S7-PLCSIM is installed software, it will appear in the installed programs area of the Microsoft Windows Control Panel. Click the "S7-PLCSIM V14" entry and then choose to uninstall or to modify (repair).

You can repair or uninstall S7-PLCSIM V14 without affecting other installed versions of S7-PLCSIM or any other installed SIMATIC software.
2.5 Differences between S7-PLCSIM products

There are several products with "S7-PLCSIM" in the title.

S7-PLCSIM V14 (this product)

This version of S7-PLCSIM supports the following SIMATIC CPU families:
- With a STEP 7 Basic license, S7-1200 and S7-1200F CPUs are supported
- With a STEP 7 Professional license, S7-1200, S7-1200F, S7-1500, S7-1500C, S7-1500T, S7-1500F, ET 200SP, and ET 200SPF CPUs are supported

S7-PLCSIM V5.x

S7-PLCSIM V5.x simulates the following SIMATIC CPU families:
- S7-300 and S7-300F
- S7-400 and S7-400F

S7-PLCSIM and S7-PLCSIM V5.x are separate software applications. You can install and run both of them on the same machine. You can also simulate communication using this combination of applications.

S7-PLCSIM V14 Advanced

S7-PLCSIM V14 Advanced and S7-PLCSIM V14 cannot be installed on the same machine. Therefore, you cannot simulate communication using this combination of applications.

2.6 Supported hardware

2.6.1 Hardware support based on STEP 7 license

Your TIA Portal license determines which PLCs you can simulate with S7-PLCSIM.

TIA Portal Basic and S7-PLCSIM

With a TIA Portal Basic license, you can simulate the following CPU families in S7-PLCSIM:
- S7-1200 with firmware version 4.0 or higher
- S7-1200F with firmware version 4.1 or higher

If your project contains PLCs with older firmware versions, the "Start simulation" button in TIA Portal is not selectable and you cannot start a simulation.

You can start and run two S7-1200 or S7-1200F simulations at the same time with any combination of these two CPU families.
TIA Portal Basic does not support the following CPU families:
- S7-1500, S7-1500C, S7-1500T, and S7-1500F
- ET 200SP and ET 200SPF

**TIA Portal Professional and S7-PLCSIM**

With a TIA Portal Professional license, you can simulate any of the following CPU families:
- S7-1200 with firmware version 4.0 and higher
- S7-1200F with firmware version 4.1 and higher
- S7-1500, S7-1500C, S7-1500T, and S7-1500F with any firmware version
- ET 200SP and ET 200SPF with any firmware version

You can start and run two simulations at the same time with any combination of these PLCs.

**Note**
- S7-1500C is the compact version of the S7-1500 family.
- S7-1500T is the technology version of the S7-1500 family.
- An "F" at the end of the CPU family designates the fail-safe version of that family.

2.6.2 **Steps for recognizing hardware with upgraded firmware**

If you have installed or updated a device's firmware in the TIA Portal using a hardware support package (HSP), those devices might not appear in the Device configuration.

If you change the firmware version of your hardware and then attempt to use an existing S7-PLCSIM project, you will receive the error that loading to the target system is not possible.

You will receive this error if, for example, you have upgraded an S7-1500 CPU from firmware version 1.8 to firmware version 2.0 and then attempt to use a project you created for an S7-1500 version 1.8.

2.7 **S7-PLCSIM concepts**

2.7.1 **Starting to work in S7-PLCSIM**

The user interface for S7-PLCSIM consists of two main views: Compact view and Project view.

You can choose to start work in either Compact view or in Project view based on how you intend to use S7-PLCSIM.
2.7.2 Compact view and Project view

2.7.2.1 Starting in Project view vs. Compact view

Compact view

Compact view consists of one small main window with a limited number of controls and functionality. S7-PLCSIM launches very quickly when you start with Compact view.

This view will be useful to you if you want to debug your program within STEP 7 rather than in S7-PLCSIM. Compact view uses only a small part of your PC desktop, allowing you to debug your program in STEP 7 while having S7-PLCSIM open at the same time.

S7-PLCSIM launches in Compact view by default. If you want to make Project view the default view, you can make this change in the Project view main menu under Options > Settings.

Project view

Project view contains the full functionality of S7-PLCSIM. Project view has much the same look and feel as the user interface of the TIA Portal.

When you launch in, or switch to, Project view, S7-PLCSIM starts more slowly than when you launch in Compact view. This is because S7-PLCSIM is incorporating the extra functionality of project view during the startup process.

Project view consists of several components:

- Main menu and main toolbar
- Options and settings (accessed from the main menu)
- Project tree
- Device configuration view
- SIM table editor
- Sequence editor

Project view will be useful to you if you prefer to debug your program using the full functionality of S7-PLCSIM, rather than performing debugging tasks in STEP 7.

2.7.2.2 Switching between Compact view and Project view

Regardless of which view you selected as the default, you can easily switch between Compact view and Project view at any time by using the "switch views" button.

What displays when you switch from one view to the other is dependent on the state of the application at the time you switch; for example, whether your simulation is configured or not, whether the simulation is running, whether you are working with an open project, and so forth.

For example, if you are currently in Compact view, you cannot create, save, or work directly with a project. Therefore, you would switch to Project view to perform any of those actions.
If you are currently in Project view, you might want to switch to Compact view so that S7-PLCSIM does not take up as much room on the computer screen, allowing you to work more efficiently in the TIA Portal.

2.7.3 Separation of simulations and projects

Prior to S7-PLCSIM V14, projects and running simulations were inseparable.

With S7-PLCSIM V14, projects and simulations are separated. You can have a project without starting a simulation, and you can run a simulation without creating or opening a project.

2.7.4 Starting and stopping a simulation

2.7.4.1 Starting and stopping a simulation

S7-PLCSIM V14 has a power button for starting and stopping a simulation.

Remember that beginning with S7-PLCSIM V14, starting and stopping a simulation is a separate task from creating or opening an S7-PLCSIM V14 project.

The power button is supported in both Compact view and Project view as shown in the screenshots below:

<table>
<thead>
<tr>
<th>Power button and CPU family selector in Compact view</th>
<th>Power button and CPU family selector in Project view</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Compact View" /></td>
<td><img src="image2.png" alt="Project View" /></td>
</tr>
</tbody>
</table>

To start a new simulation, select the correct CPU family from the drop-down list, then click the power button to launch the simulation.

While a simulation is running, the power button is green and the CPU family selector is disabled.

You can stop the running simulation by again clicking the power button.

Clicking the power button ends the current simulation. It is not the same as setting the simulation to "STOP" mode. When you click the power button it has the same functionality as turning off the power supply for a "real" PLC.
You can stop a simulation regardless of whether there is an open S7-PLCSIM project. If there is an open project and you are in Project view, the Project tree is updated to show this state. Stopping the simulation also causes Project view to go “offline”. You will no longer be able to run SIM tables or sequences.

In Compact view, the visual changes are more subtle. The power button will be gray and the CPU family selector becomes visible.

There are two possible use cases for stopping a simulation:

- You want to simulate a power cycle operation
- You want to change the CPU family being simulated
2.7.4.2 Simulation and the power button

The power button is available in both Compact view and Project view. You use the power button to turn a simulation on or off.

The power button is green when a simulation is running, whether the simulation is configured or unconfigured.

The power button is gray when you are not running a simulation.

Examples of power button use

The screen capture below shows the Compact view with a running, configured S7-1500 simulation.

- the power button is green
- the configured CPU name is displayed
- the communications address is shown
- the LEDs are active
- the Run/Stop/MRES buttons are enabled

Clicking the power button (to turn off the simulation) results in the following.
Note what has (and has not) changed in the user interface:

- the power button is gray
- the configured CPU name is still displayed
- the communications address is removed
- the LEDs are disabled
- the RUN/STOP/MRES buttons are disabled
- the CPU family selection is visible

Your simulation is saved when you stop the simulation. If you click the power button again, the new simulation starts with the same configuration as when you stopped the simulation. This has the effect of "power cycling" the previous simulation.

### 2.7.4.3 Changing the CPU family being simulated

One reason to stop a simulation is to change the CPU family you are simulating.

**Procedure for changing the CPU family**

Returning to the stopped simulation seen in the previous section:

The drop down list for CPU family is now visible. Click the down arrow to display the list of supported CPU families:
If you change CPU families and then click the power button, this starts a new, unconfigured simulation of the type you select. The saved simulation is discarded. The Compact view appears as follows:

- the "unconfigured" CPU name is displayed
- no communications address is shown
- the LEDs and the Run/Stop/MRES buttons are disabled

In the Project view, if there is an open S7-PLCSIM project, changing the simulation family and starting a new simulation will cause the project tree to update to show the new, unconfigured simulation.

### 2.7.5 Simulation states

There are three possible simulation states:

- Unconfigured simulation
- Configured simulation
- No simulation

#### Unconfigured simulation

A simulation is considered to be unconfigured if you have selected a PLC family and clicked the power button to the "on" state, but have not yet performed a download for a specific PLC from STEP 7.

In this state, S7-PLCSIM displays the PLC name as one of the following examples:

- PLC_1 [SIM-1200]
- PLC_1 [SIM-1500]
- PLC_1 [SIM-ET200SP]

An unconfigured simulation can be useful when you want to work with a certain PLC family environment but are not yet ready to work with a specific PLC.
**Configured simulation**

A simulation is considered to be configured after you have downloaded a specific PLC from STEP 7. In this case, the PLC name is displayed as, for example, "MyPLC [CPU 1215 DC/DC/DC]".

**No simulation**

S7-PLCSIM is considered to be in the "no simulation" state if the application is open but powered off. The power button is gray in this state.

If you are in the "no simulation" state, you can still create a project and set up your SIM tables and sequences in Project view.

**2.7.6 Supported STEP 7 programs for simulation**

S7-PLCSIM accepts the download of any valid program for a supported, configured CPU. With some exceptions (noted below), the downloaded program should go to RUN mode without changes.

There are three specific scenarios that require you to make changes to your STEP 7 program before you perform a download to S7-PLCSIM. Those are:

- **Know-how protection.** S7-PLCSIM does not support simulation of user know-how protected blocks. In order to simulate projects that contain know-how protected blocks, it is necessary that you first remove the protection from the block(s) before you download your project to S7-PLCSIM.

- **Fail-safe programs.** S7-PLCSIM supports fail-safe program simulation. However, you might need to increase the F-cycle time because scan times for the simulation will be longer.

- **S7-1500 motion programs.** S7-PLCSIM supports the simulation of S7-1500 SMC (simple motion control) configurations. However, in order to successfully run these programs, you might need to increase the motion cycle time because scan times for the simulation will be longer.
2.7.7 RUN and STOP modes and simulation

The simulated PLC supports downloads while in RUN mode.

S7-PLCSIM writes output values when you put the simulated PLC in STOP mode.

2.7.8 Differences between a simulated PLC and a "real" PLC

2.7.8.1 Overview of differences

The virtual PLC is not fully able to simulate a real PLC. There might be differences in the behavior of the virtual PLC compared to a real PLC. Sometimes the differences apply to all CPU families, and other times to only one CPU family or specific CPU.

Many system CPU functions (SFCs and SFBs) have limited behavior for simulation. Programs that rely on this functionality behave differently during simulation.

Also, programs that are very dependent on timing might be difficult to debug with a simulation, since the simulation timing is not nearly as deterministic as timing for a real PLC.

2.7.8.2 Differences common to all supported PLCs

I/O device support

S7-PLCSIM does not support specialized I/O module functionality. It provides only process image and direct access simulation of I/O registers.

An example of how you can observe this specialized functionality is with analog output range monitoring. On a real module, if an out-of-range value is written to an analog output register, the analog module throws a diagnostic error. This will not occur in S7-PLCSIM. Any of the functionality that would have been performed by the physical module is not simulated in S7-PLCSIM.

Know-how protected blocks

S7-PLCSIM V14 does not support know-how or password protected blocks. You must remove the protection before performing a download to S7-PLCSIM.

PC-based controllers

S7-PLCSIM V14 does not support simulation of a PC-based controller.

Diagnostics

S7-PLCSIM does not support all of the error messages written to the diagnostic buffer. For example, S7-PLCSIM does not simulate messages about bad batteries in the CPU, or EPROM errors. However, S7-PLCSIM simulates most program errors.
Time-based performance

Because S7-PLCSIM is software running on a PC under the Windows operating system, the scan cycle time and the exact time of actions in S7-PLCSIM is not the same as if those actions were performed on physical hardware.

If your program is highly dependent on the time that actions execute, be aware that you should not evaluate your program based only on the time results of your S7-PLCSIM simulation.

Access and copy protection

S7-PLCSIM does not simulate access protection or copy protection.

Flashing LEDs

You can flash the LED lights on a PLC in the STEP 7 "Extended download to device" dialog box, but S7-PLCSIM does not simulate this functionality.

Features requiring the SD memory card

S7-PLCSIM does not simulate SD memory cards. Therefore, you cannot simulate CPU functionality that requires a memory card. For example, the data logging feature writes all output to the SD card, so the data logging feature cannot be simulated.

Data logging

S7-PLCSIM does not support data logging because this feature writes all output to the SD card, and S7-PLCSIM does not support the use of an SD card.

Recipes

S7-PLCSIM does not support recipes because recipe data is stored in an SD card and S7-PLCSIM does not support the use of the SD card.

Web server

S7-PLCSIM does not support Web server functionality.

PROFIBUS

If your STEP 7 project contains PROFIBUS elements, S7-PLCSIM will not simulate the PROFIBUS elements, but the remainder of your project simulates as usual.

You do not need to remove the PROFIBUS elements from your project before starting your simulation. Just be aware that S7-PLCSIM ignores the PROFIBUS elements.
Simulating motion control

Motion control overview

S7-PLCSIM supports STEP 7 projects containing motion control configurations and functionality for S7-1500, S7-1500C, S7-1500T, S7-1500F, ET 200SP, and ET 200SPF CPUs.

Note
S7-1200 motion control projects
S7-PLCSIM does not support motion control for S7-1200 or S7-1200F CPUs.

Simulations and the homing mode

With a real CPU, homing is set directly and the state "reference" correspondingly to it. The hardware inputs are not evaluated.

Motion control simulation limitations

Be aware that your simulation results might be limited if any of the following are true:

- Your project uses very short cycle times
- Your project has a hardware configuration with a large number of devices, such as drives
- Your project uses a large number of technology objects, such as positioning axis

The behavior of your simulation also depends on the type of technology object(s) you use.

See also

Wait briefly after going to RUN mode to access motion control technology objects (Page 139)

Motion control technology objects

TO_PositioningAxis

With the TO_PositioningAxis technology object, the simulated drive provides feedback regarding position functions to S7-PLCSIM.

Axis position feedback

The setpoint (position) is integrated with a certain time delay (PT1 element). The result of this calculation is fed back to the TO_PositioningAxis object as the actual position of the axis.
Homing axis

If you have selected the homing mode "Use zero mark via PROFIdrive telegram" in STEP 7, S7-PLCSIM responds immediately to every active (Mode 2, 3, 8) or passive (Mode 4, 5) homing command (MC_Home) with the actual position being set as the home position.

Simulation restrictions

- S7-PLCSIM does not simulate an analog positioning axis.
- With Dynamic Servo Control (DSC) telegram 5, you might need to adjust the STEP 7 settings under "Control loop: Precontrol and velocity gain (Kv factor)" and/or under "Positioning monitoring > Following error" to obtain meaningful simulation behavior. Adjust these settings incrementally until your simulation responds as expected.

TO_ExternalEncoder

With the TO_ExternalEncoder technology object, the simulated external encoder provides static/fixed position feedback, which is set by homing commands, to S7-PLCSIM.

Homing

Active homing is not possible with the TO_ExternalEncoder object.

If you have selected the passive homing mode "Use zero mark via PROFIdrive telegram" in STEP 7, S7-PLCSIM responds immediately to every passive (Mode 4, 5) homing command (MC_Home) with the actual position being set as the home position.

Restrictions with motion control

There are motion control resources on each CPU that can be distributed to the technology objects.

S7-PLCSIM supports a maximum of 5120 motion control resources. The simulation of motion control is therefore restricted for the following CPUs:

<table>
<thead>
<tr>
<th>CPU type</th>
<th>Article number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>CPU 1517-3 PN/DP</td>
</tr>
<tr>
<td>Standard</td>
<td>CPU 1518-4 PN/DP</td>
</tr>
<tr>
<td>Standard</td>
<td>CPU 1518-4 PN/DP ODK</td>
</tr>
<tr>
<td>Fail-safe</td>
<td>CPU 1517F-3 PN/DP</td>
</tr>
<tr>
<td>Fail-safe</td>
<td>CPU 1518F-4 PN/DP</td>
</tr>
<tr>
<td>Fail-safe</td>
<td>CPU 1518F-4 PN/DP ODK</td>
</tr>
<tr>
<td>Technology</td>
<td>CPU 1517T-3 PN/DPP</td>
</tr>
<tr>
<td>Technology</td>
<td>CPU 1517TF-3 PN/DPP</td>
</tr>
</tbody>
</table>

1 The ODK functionality of this CPU is not simulated.
2 The simulation of this CPU supports only 64 cams.
Exceeding the quantity structure

STEP 7 checks whether the quantity structure for a configured CPU is complied with, and alerts you when it is exceeded. When you load a project into a CPU, another message appears.

Note
A project that uses more than 5120 motion control resources can be downloaded to a virtual controller. However, there is no message indicating that the quantity structure has been exceeded.

After your program accesses the technology objects, you can observe the following indications if the quantity structure has been exceeded:
• an error message at the block
• a value of zero for the object

2.7.8.3 Differences specific to S7-1200 PLCs

S7-1200 CPU and firmware version compatibility
S7-PLCSIM simulates only the following S7-1200 PLCs:
• S7-1200 PLCs with firmware version 4.0 or higher
• S7-1200F PLCs with firmware version 4.1 or higher

Adjusting STEP 7 program settings for S7-1200 Fail-safe CPUs
In order to simulate an S7-1200F PLC, you must adjust the F-parameter F-monitoring time in your STEP 7 project before you perform a download to S7-PLCSIM. This is due to the difference in timing between a software-based simulation and actual physical hardware.

Procedure to adjust the F-monitoring time in STEP 7
To adjust the F-monitoring time, follow these steps:
1. In the STEP 7 Project tree, right-click your F-CPU and select "Properties".
2. In the Properties dialog, go to "Fail-safe > F-parameter > Default F-monitoring time for central F-I/O".
3. Adjust the F-monitoring time from the default of 150 ms to a higher value.
4. Click OK.

You might need to repeat this procedure until you find an F-monitoring value that allows your F-CPU simulation to run without errors.
Technology module and technology object support: S7-1200

Technology module support
S7-PLCSIM does not simulate the following technology modules:

- Counting
- PID Control
- Motion Control

Technology object support
S7-PLCSIM does not currently support the following technology objects:

- Motion control
- PID

Instruction support: S7-1200
S7-PLCSIM supports almost all instructions for the simulated S7-1200 and S7-1200F in the same way as for a physical PLC.

Some instructions are partially supported. For these instructions, S7-PLCSIM validates input parameters and returns outputs that are valid, but not necessarily what a real PLC with physical I/O would return. For example, S7-PLCSIM does not support the SIMATIC memory card and program instructions that save data log data on a memory card do not actually save any data when executed.

You can download all programs that successfully compile to the virtual PLC. However, some instructions call SFCs (system functions) or SFBs (system function blocks) that are partially supported.

Supported communication instructions: S7-1200
S7-PLCSIM supports the following communication instructions for the S7-1200 and S7-1200F PLCs:

- PUT and GET
- TSEND and TRCV
- TSEND_C and TRCV_C

2.7.8.4 Differences specific to S7-1500 PLCs

S7-1500 CPUs and firmware version compatibility
S7-PLCSIM V14 supports all firmware versions of the S7-1500, S7-1500C, S7-1500T, and S7-1500F CPUs.
Adjusting STEP 7 program settings for S7-1500 Fail-safe CPUs

In order to simulate an S7-1500F PLC, you must adjust the F-parameter F-monitoring time in your STEP 7 project before you perform a download to S7-PLCSIM. This is due to the difference in timing between a software-based simulation and actual physical hardware.

Procedure to adjust the F-monitoring time in STEP 7

To adjust the F-monitoring time, follow these steps:
1. In the STEP 7 Project tree, right-click your F-CPU and select "Properties".
2. In the Properties dialog, go to "Fail-safe > F-parameter > Default F-monitoring time for central F-I/O".
3. Adjust the F-monitoring time from the default of 150 ms to a higher value.
4. Click OK.

You might need to repeat this procedure until you find an F-monitoring value that allows your F-CPU simulation to run without errors.

Technology module and technology object support: S7-1500

Technology module support

S7-PLCSIM supports the following technology modules for the S7-1500, S7-1500C, and S7-1500F:
- Counting and measurement
- PID Control
- Time-based IO
- Motion Control

Technology object support

S7-PLCSIM supports the following technology objects for the S7-1500, S7-1500C, and S7-1500F:
- Motion Control
- PID
- Counting and measurement

Instruction support: S7-1500

S7-PLCSIM supports almost all instructions for the S7-1500, S7-1500C, and S7-1500F in the same way as a physical PLC.

Some instructions are partially supported. For these instructions, S7-PLCSIM validates input parameters and returns outputs that are valid, but not necessarily what a real PLC with physical I/O would return. For example, S7-PLCSIM does not support the SIMATIC memory...
card and instructions that create data log data on a memory card cannot actually read or write to a memory card.

You can download all programs that successfully compile to the virtual PLC. However, some instructions call SFCs (system functions) or SFBs (system function blocks) that are partially supported.
Supported communication instructions: S7-1500

S7-PLCSIM supports the following communication instructions for the S7-1500, S7-1500C, and S7-1500F PLCs:

- PUT and GET
- BSEND and BRCV
- USEND and URCV
- TSEND and TRCV
- TSEND_C and TRCV_C

2.7.8.5 Differences specific to ET 200SP PLCs

ET 200SP CPUs and firmware version compatibility

S7-PLCSIM V14 supports all firmware versions of the ET 200SP and ET 200SPF CPUs.

Adjusting STEP 7 program settings for ET 200SP Fail-safe CPUs

In order to simulate an ET 200SPF PLC, you must adjust the F-parameter F-monitoring time in your STEP 7 project before you perform a download to S7-PLCSIM. This is required because of the difference in timing between a software-based simulation and actual physical hardware.

Procedure to adjust the F-monitoring time in STEP 7

To adjust the F-monitoring time, follow these steps:

1. In the STEP 7 Project tree, right-click your F-CPU and select "Properties".
2. In the Properties dialog, go to "Fail-safe > F-parameter > Default F-monitoring time for central F-I/O".
3. Change the F-monitoring time from the default of 150 ms to a higher value.
4. Click OK.

You might need to repeat this procedure until you find an F-monitoring value that allows your F-CPU simulation to run without errors.

Technology module and technology object support: ET 200SP

Technology module support

S7-PLCSIM supports the following technology modules for the ET 200SP and ET 200SPF:

- Counting and measurement
- PID Control
S7-PLCSIM overview

2.7 S7-PLCSIM concepts

- Time-based IO
- Motion Control

**Technology object support**

S7-PLCSIM supports the following technology objects for the ET 200SP and ET 200SPF:

- Motion Control
- PID
- Counting and measurement

**Instruction support: ET 200SP**

S7-PLCSIM supports almost all instructions for the ET 200SP and the ET 200SPF in the same way as a physical PLC.

Some instructions are partially supported. For these instructions, S7-PLCSIM validates input parameters and returns outputs that are valid, but not necessarily what a real PLC with physical I/O would return. For example, S7-PLCSIM does not support the SIMATIC memory card and instructions that create data log data on a memory card cannot actually read or write to a memory card.

You can download all programs that successfully compile to the virtual PLC. However, some instructions call SFCs (system functions) or SFBs (system function blocks) that are partially supported.
Supported communication instructions: ET 200SP

S7-PLCSIM supports the following communication instructions for the ET 200SP and ET 200SPF PLCs:

- PUT and GET
- BSEND and BRCV
- USEND and URCV
- TSEND and TRCV
- TSEND_C and TRCV_C

2.8 Using the help system

2.8.1 Overview of the help system

A comprehensive online help system describes the features and procedures you need to work more effectively with S7-PLCSIM. The S7-PLCSIM help system functions in the same way as the TIA Portal help system. It opens in a separate window from the main S7-PLCSIM application so that you can continue to work while you obtain the information you need.

You can launch the online help in the following ways:

- Select "Show help" under "Help" on the main menu
- Click the F1 key anywhere in the application

Online help available in electronic manual format

The online help is also available in electronic manual format from:

- the installation disk
- your hard drive after installation

This gives you several ways to access the help in the format that is most useful to you, and makes it easier to print.
Intended audience

The help documentation is intended for personnel with knowledge of, and experience using:

- Industrial automation and automation engineering
- PLC programming
- SIMATIC PLCs
- STEP 7
- TIA Portal

S7-PLCSIM Readme and online Readme files

The Readme file included with S7-PLCSIM V14 contains information that could not be included in the online help at the time the product was released. Information in the Readme file supersedes information in other documentation, and it is recommended that you read it carefully.

Additionally, the Readme file is updated as needed, and the updates are posted online. If you encounter unexpected behavior in S7-PLCSIM, consult the online version of the Readme file to see if there is a topic that addresses your issue. Visit the Siemens Industry Online Support [https://support.industry.siemens.com/cs/?Ic=en-US] website and search for “S7-PLCSIM V14 Readme”.

Note

Each S7-PLCSIM version has a separate online Readme file

There is a separate online Readme file for each release of S7-PLCSIM, so be sure you have located the online Readme for S7-PLCSIM V14 rather than for one of the earlier versions.

Online service and support

All of the SIMATIC product and system technical documentation is available on the Siemens Industry Online Support [https://support.industry.siemens.com/cs/?Ic=en-US] website, where you can find the following information:

- News about the latest information on your products
- Documentation for your products
- Forums for worldwide knowledge exchange between users and experts
- Your local contact for Siemens Industry products and services
- Information about on-site services, repairs, spare parts, and much more
2.8.2 Searching the help system

As of S7-PLCSIM V14, the information system contains both the S7-PLCSIM help and the TIA Portal help. The two help systems appear under the "Content" tab. Under the "Content" tab:

- the S7-PLCSIM help is designated as "S7-PLCSIM online help".
- the TIA Portal help is designated as "Information System".

Search result display

When you search for information, results might show matching topics from both the S7-PLCSIM help and the TIA Portal help.

As an example, search on the term "display format" in the "Search for:" box on the left-hand side of the information system. The results of the search will contain both S7-PLCSIM and TIA Portal topics.

If you want to view only the S7-PLCSIM help search results, sort on the "Position" column header and the S7-PLCSIM help search results are grouped together. In this way you can be sure you are seeing all of the S7-PLSCIM search results. This makes it easier for you to determine which S7-PLCSIM help topic will address your display format question in the way that is most useful to you.

2.8.3 Readme and Online Readme files

The S7-PLCSIM V14 Readme and Online Readme files provide information on working with S7-PLCSIM V14 that was not known at the time the product was released for sale.

S7-PLCSIM Readme file

The Readme file is available at the time you install S7-PLCSIM V14.

You can access the Readme file during installation by clicking the "Read product information" button.

You can access the Readme file after installation by searching for the the file in one of two ways:

- Navigate to the folder in which you installed S7-PLCSIM V14
- Search for the specific file on your hard drive by using the Windows Start menu search box
There is one Readme file for each language, as follows:

<table>
<thead>
<tr>
<th>Language</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chinese (simplified)</td>
<td>ReadMePE2MzhCN.chm</td>
</tr>
<tr>
<td>English</td>
<td>ReadMePE2MenUS.chm</td>
</tr>
<tr>
<td>French</td>
<td>ReadMePE2MfrFR.chm</td>
</tr>
<tr>
<td>German</td>
<td>ReadMePE2MdeDE.chm</td>
</tr>
<tr>
<td>Italian</td>
<td>ReadMePE2MitIT.chm</td>
</tr>
<tr>
<td>Spanish (modern)</td>
<td>ReadMePE2MesES.chm</td>
</tr>
</tbody>
</table>

**S7-PLCSIM Online Readme file**

The Readme file is updated as needed, and the updates are posted online as Online Readme files.

If you encounter unexpected behavior in S7-PLCSIM, consult the online version of the Readme file to see if there is a topic that addresses your issue. Visit the Siemens Industry Online Support website [https://support.industry.siemens.com/cs/?lc=en-US](https://support.industry.siemens.com/cs/?lc=en-US) and search for "S7-PLCSIM V14 Readme".

There is an Online Readme file for each language.

**Note**

Each S7-PLCSIM version has a separate online Readme file

There is a separate online Readme file for each release of S7-PLCSIM, so be sure you have located the online Readme for S7-PLCSIM V14 rather than for one of the earlier versions.
3.1 Overview of startup options

There are many options you can use to start working with S7-PLCSIM.

The following sections provide details about the ways you can begin working with S7-PLCSIM. Choose the startup option that best suits your specific application.

3.2 Startup from TIA Portal

3.2.1 Overview of startup from the TIA Portal

Any simulation project must get its hardware configuration and executable program from a STEP 7 project via a download. Starting S7-PLCSIM directly from the TIA Portal makes this as easy as possible.

Note that you cannot create or edit the configured hardware or STEP 7 user program in S7-PLCSIM. You must make any alterations to these components in the TIA Portal.

3.2.2 Using the Start simulation command

In STEP 7, the "Start simulation" option is available for devices that S7-PLCSIM is able to simulate. When S7-PLCSIM V14 is installed, the simulation options are enabled for the supported PLC families (S7-1200; S7-1500; ET 200SP).

In STEP 7, starting a simulation is available either from the main toolbar, or from the shortcut menu for a device in the Project tree. These options are enabled when you select a supported CPU in the Device configuration view or in the Project tree.

In the S7-PLCSIM application options settings, you can select how you want to launch S7-PLCSIM. The application can be launched in "Compact view" or "Project view". The following sections discuss the behavior and implications of this choice.

NOTE: In previous versions of S7-PLCSIM, the "Start simulation" command from STEP 7 would first look for any active simulation that could be used. Only if none were found would a new S7-PLCSIM instance be launched. This is no longer true for V14. Selecting "Start simulation" will always launch a new instance of S7-PLCSIM. If you want to connect to an already-running instance of S7-PLCSIM, you should select the "Download" command.
3.2.3 Launching in Compact view with the Start simulation command

When you select "Start simulation" in STEP 7, and have selected to launch S7-PLCSIM in Compact view, the following will occur:

- A new instance of the S7-PLCSIM Compact view is launched.
- The new S7-PLCSIM instance starts a simulation for the selected PLC family (S7-1200; S7-1500; or ET 200SP).
- When the simulation is active, a STEP 7 download begins.

Once the download is complete, you can go online from STEP 7 to debug your program, or you can switch to Project view to use the debugging tools in the SIM table editor and Sequence editor.

3.2.4 Launching in Project view with the Start simulation command

When you select "Start simulation" in STEP 7, and you have selected to launch S7-PLCSIM in Project view, the following will occur:

- A new instance of the S7-PLCSIM Project view is launched.
- S7-PLCSIM starts a simulation for the selected PLC family (S7-1200; S7-1500; or ET 200SP).
- When the simulation is active and ready, the STEP 7 download commences.

Once the download is complete, you can "go online" from STEP 7 to debug your program.

Note that launching S7-PLCSIM and starting a simulation does not automatically create an S7-PLCSIM project.

3.3 Startup from desktop icon or start menu

3.3.1 Overview of starting from a desktop icon or start menu

You can launch S7-PLCSIM in Compact view or Project view from the desktop shortcut or the start menu entry.

For V14, the application option setting for "load most recent project during startup" is no longer an option.

Therefore, when you launch from the desktop icon or start menu, S7-PLCSIM is loaded without an open project. The specific behavior and available options are described elsewhere for both the Compact view and the Project view section of this document.
3.4 Startup from an existing S7-PLCSIM project

3.4.1 Overview of startup from an existing project

You can use previously saved S7-PLCSIM projects for simulation. The S7-PLCSIM project contains the SIM tables and sequences that you previously created and saved. Your project also contains the hardware and software configuration you downloaded to the simulation. The configuration is automatically restored to the simulation when you open the S7-PLCSIM project.

There are two ways you can open an existing S7-PLCSIM project:

- open by double-clicking the file in Windows Explorer
- open from the S7-PLCSIM main menu or main toolbar in Project view

3.4.2 Open a project by double-clicking the file name

You can open an existing project by double-clicking a *.sim14 project in file explorer. In this case, S7-PLCSIM will always launch in Project view, regardless of the application setting for "Start view". The following will occur:

- The Project view opens and displays the SIM tables and sequences for the project.
- If the project has a saved simulation, the correct family of virtual PLC is launched.
- If the virtual PLC was previously configured by a download, it goes online with the running simulation, and displays the hardware configuration in Device configuration.

3.4.3 Open project from main menu "Project" and main toolbar

Project view has an "Open project" entry under "Project" in the main menu, and an "open project" button on the main toolbar.

You cannot open a project while you are in Compact view. You must switch to Project view to open a project.

3.4.4 Opening an S7-PLCSIM V13 SP1 project

A project created and saved with S7-PLCSIM V13 SP1 can be directly opened in S7-PLCSIM V14. When you select the project, a message box displays to notify you that the project must be converted to an S7-PLCSIM V14 (*.sim13 to *sim14). Part of the upgrade process is to make a new project folder for the upgraded project. Once the upgrade is complete, the project opens normally. This newly-converted project will then be saved in a format that is no longer compatible with S7-PLCSIM V13 SP1.
3.4.5 Opening a project created prior to V13 SP1

It is not possible to directly open S7-PLCSIM projects created and saved with a version older than S7-PLCSIM V13 SP1. To open these projects with S7-PLCSIM V14, follow this procedure:

1. Open the project with S7-PLCSIM V13 SP1.
2. Save the project as an S7-PLCSIM V13 SP1 project.
3. Open the project with S7-PLCSIM V14.

3.4.6 Using an existing S7-PLCSIM project for simulation and debugging

Once you have opened the S7-PLCSIM project, the simulation is active and ready for debugging in either S7-PLCSIM or STEP 7.

If you open a project that was previously used to create the simulation, you can simply open this project and “go online” with the correct CPU, using the same procedure that you would use to go online with a real PLC.

If you do not have the STEP 7 project that was previously used to create the simulation, it is still possible to use STEP 7 for debugging. You can open a new STEP 7 project and select to upload from the running simulation. When you do this, the hardware configuration and project are created in the STEP 7 project, and you can go online with the running simulation. Again, this is the same behavior as if you were connected with a real PLC.
Modifying a running simulation

4.1 Overview of modifying a running simulation

After a simulation begins running, you are still able to download any changes you make in the TIA Portal to your program or configured hardware.

S7-PLCSIM accepts any changes to your hardware configuration without error as long as you do not change the CPU family of the hardware. The following example scenarios illustrate a successful download and an unsuccessful re-configuration of the simulation.

Example scenario: change to CPU of the same family

1. You first download the hardware and software of a project configured for a CPU 1211 V4.0 (6ES7 211-1AE40-0XB0).
2. You then change the hardware configuration to be a CPU 1217 V4.2 (6ES7 217-1AG40-0XB0).
3. Then you download the hardware configuration.

This scenario would not be allowed for a "real" PLC. The V4.0 device would not accept the download of a V4.2 configuration because the TIA Portal would block the download. However, this is allowed for a simulation. The download dialog will indicate that the download is to a simulation. The download will succeed, and you can view the result in Device configuration view.

Example scenario: change to CPU of a different family

It is not possible to change the CPU family for a running simulation. Consider the following example scenario:

1. You first download the hardware and software of a project configured for a CPU-1211 V4.0 (6ES7-211-1AE40-0XB0).
2. You then change the hardware configuration to be a CPU-1511 V2.0 (6ES7 511-1AK01-0AB0).
3. You then attempt to download the hardware configuration.

This scenario is blocked because the TIA Portal will not find a suitable download target.
4.2 Simulating a power cycle

The screen capture below shows the compact view with a running, configured S7-1200 CPU simulation.

Notice the following:

- The power button is green
- The configured CPU name is displayed
- The communications (IP) address is shown
- The LEDs are active
- The RUN, STOP, and MRES buttons are enabled

Clicking the power button to turn off the simulation results in the following:

Note what has, and has not, changed in the user interface:

- The power button is gray
- The configured CPU name is still displayed
- The communications (IP) address is removed
- The LEDs are disabled
- The RUN, STOP, and MRES are disabled
- The CPU family selection is visible
The virtual PLC configuration is saved when you stop the simulation. If you click the power button again, the new simulation starts with the same configuration. This has the effect of "power cycling" the previous simulation.

### 4.3 Changing the CPU family being simulated

Another purpose of modifying a running simulation is to change the CPU family being simulated. Here, the simulation is in Compact view in the stopped state:

The drop-down list for the CPU family is visible. Clicking the down arrow displays the list of supported CPU families:

If you change CPU families and then click the power button, this will start a new, unconfigured simulation of the family you selected. The configuration from the previous simulation is discarded. The Compact view now appears as follows:
4.4 Configured versus unconfigured simulations

When a new simulation is launched, it is said to be "unconfigured". An unconfigured simulation can accept connection requests at any network address. At startup, an unconfigured simulation has a default address for each supported communications protocol.

For example, an unconfigured S7-PLCSIM V5.x simulation has the following default addresses:

- MPI=2
- DP=2
- Local=2
- IP=192.168.0.1
- ISO=08-00-12-34-56-78

The virtual PLCs supported by S7-PLCSIM V14 only support IP communications. The default address for these communications is simply:

- IP=192.168.0.1

When STEP 7 requests to connect with a simulation at a specific address (for example, 192.168.2.34), S7-PLCSIM first checks to see if there is a configured simulation at that address. If yes, then STEP 7 connects to that simulation.

If there is no existing simulation configured for that address, then the driver will connect STEP 7 to the first unconfigured simulation.

When an unconfigured simulation receives a hardware download, S7-PLCSIM recognizes that this simulation is now configured and will no longer allow connections to the simulation except for the specific, configured address.
5.1 Overview of working in Compact view

Compact view is the default view for S7-PLCSIM. It has a small computer screen "footprint", and can function as a virtual PLC while you debug your program using STEP 7.

If you prefer to launch in Project view, you can change the default view from the Project view main menu under Options > Settings.

Compact view performance enhancement

As of S7-PLCSIM V14, the functionality of Compact view has changed significantly. The new Compact view user interface design allows S7-PLCSIM to launch more quickly than in previous versions.

You can no longer perform project actions or run sequences in Compact view. You must switch to Project view in order to use these functions.

The new functionality of Compact view is detailed in the following sections.

See also

Compact view user interface (Page 46)
5.2 Compact view user interface

When you launch S7-PLCSIM V14 in Compact view from your computer desktop, Compact view opens with no project and no simulation.

The following screenshot shows Compact view in this state:

![Compact view screenshot](image)

**Compact view functionality has changed**

As of S7-PLCSIM V14, the functionality of Compact view has changed significantly. This change enables S7-PLCSIM to launch more quickly than in previous versions when you select to launch in Compact view.

As of S7-PLCSIM V14, you must switch to Project view to perform project actions and manage sequences.

**Description of the Compact view user interface**

Compact view has four main sections:

- Title bar
- CPU name
- CPU control panel
- Project name
① Title bar

Displays the S7-PLCSIM logo and three control buttons:

- "Keep on top" button: Causes Compact view to display on top of all other windows.
- "Minimize" button: Standard Windows functionality.
- "Close button": Standard Windows functionality.

② CPU name

This section of Compact view shows the name and type of the virtual PLC. Different text is displayed based on the state of the application:

- No open simulation - displays "<no simulation>"
- Unconfigured simulation (no download has been performed) - displays "Unconfigured"
- "Configured simulation (a download has been performed) - displays the name you assigned the CPU, along with the CPU type (for example, "MyPLC [CPU 1215 DC/DC/DC"]

The CPU name section also has contains the "Switch to project view" button.
5.3 Using memory reset (MRES) in Compact view

A memory reset clears all working memory areas and copies load memory to working memory. You can perform a memory reset by using the MRES button in Compact view.

Memory reset procedure

Initial state: you are running an active simulation.
- If you are in Project view, switch to Compact view.
- Click the MRES button.
- The virtual PLC goes to STOP without prompting you to confirm the action.
- STEP 7 goes offline.
- The connection between STEP 7 and S7-PLCSIM is broken.
- S7-PLCSIM goes back online automatically.
- STEP 7 does not automatically go online.

Result: M memory and Data Block values return to their start values.
6.1 Project view user interface

6.1.1 Project view user interface overview

Project view provides the full functionality of S7-PLCSIM. The screenshot below shows the main components of the Project view with two editors visible in a horizontally split window:
Working in Project view

6.1 Project view user interface

① Title bar
Displays the project path and project name, and buttons to switch to Compact view, minimize the application, maximize the application, and close S7-PLCSIM.

② Menu bar
Displays menus for project commands, edit commands, execute commands, options settings, tool commands, window commands, and help commands.

③ Toolbar
Displays buttons for project commands, edit commands, execute commands, switching to Compact view, window commands, recording tool commands, and the simulated PLC's IP address.

④ Project tree
Displays the project name, the simulated PLC type, and navigation to Device configuration, SIM tables, and sequences.

⑤ Editor windows
Displays editors for Device configuration, SIM tables, and sequences. You can display two editors at the same time either horizontally or vertically.

⑥ Editor bar / status bar with progress display
Displays shortcuts to open editors and the status of the simulated PLC.

Switching to Compact view from Project view
You can switch from Project view to Compact view by clicking the "Switch to Compact view" button on the main toolbar.

6.1.2 The S7-PLCSIM menu bar

6.1.2.1 S7-PLCSIM menu bar
The following image shows the user interface for the S7-PLCSIM main menu, along with a description of each section of the menu:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Contains commands for creating new projects; opening existing projects; closing, deleting, and saving projects; and exiting S7-PLCSIM. There is also a list of your most recent projects.</td>
</tr>
<tr>
<td>Edit</td>
<td>Contains commands to open, cut, copy, paste, delete, and rename an object in the simulation project. You can also view the properties of the simulation project, including the project name, creation time, time of the last change to the project, and the project storage path. You can also enter an author name and comments for the project.</td>
</tr>
<tr>
<td>Execute</td>
<td>Switches the simulated PLC to RUN mode or to STOP mode.</td>
</tr>
<tr>
<td>Options</td>
<td>Opens the settings dialog so you can adjust the application settings.</td>
</tr>
<tr>
<td>Window</td>
<td>Allows you to customize the workspace.</td>
</tr>
<tr>
<td>Help</td>
<td>Opens the help system, provides a link to the Siemens Industry Online Support website, and shows details of the installed software.</td>
</tr>
</tbody>
</table>
6.1.2.2 S7-PLCSIM menu bar commands

S7-PLCSIM project menu commands

The Project commands are as follows:

<table>
<thead>
<tr>
<th>Menu text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a new project and a new simulated PLC. If the current project contains unsaved changes, you are asked to save the project. S7-PLCSIM automatically assigns a name of &quot;Project(n).sim14&quot; to the new project, where (n) is the next numbered project created. You can change the project name in the Project properties if you want to do so.</td>
</tr>
<tr>
<td>Open</td>
<td>Allows you to select an existing project to open.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the current simulation project. If the current project contains unsaved changes, you are asked to save the project.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the simulation project using the current path and file name. &quot;Save&quot; is disabled during a download from STEP 7. It is also disabled after &quot;Start simulation&quot;. You must use the &quot;Save as...&quot; command for a newly opened simulation project before you can use the &quot;Save&quot; command.</td>
</tr>
<tr>
<td>Save as...</td>
<td>Allows you to save your project with a new name and/or a new path. &quot;Save as...&quot; is disabled during a download from STEP 7.</td>
</tr>
<tr>
<td>Delete project</td>
<td>Allows you to select a project for deletion.</td>
</tr>
<tr>
<td>&lt;List of recent projects&gt;</td>
<td>The application keeps a list of your most recently saved simulation projects. You can open one of the projects by clicking it. If your current project contains unsaved changes, you are asked to save the project before opening your selected project.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the simulated PLC and the S7-PLCSIM application. If the current project contains unsaved changes, you are asked to save the project.</td>
</tr>
</tbody>
</table>
S7-PLCSIM edit menu commands

The Edit functions are as follows:

<table>
<thead>
<tr>
<th>Menu text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open object</td>
<td>This menu item is enabled when an object that can be opened has application focus. This is true when the focus is on the Project tree and one of the following elements is selected:</td>
</tr>
<tr>
<td></td>
<td>• the simulated PLC</td>
</tr>
<tr>
<td></td>
<td>• a SIM table</td>
</tr>
<tr>
<td></td>
<td>• a sequence</td>
</tr>
<tr>
<td>Cut</td>
<td>Standard clipboard Cut functionality. Cut is enabled or disabled based on your current selection.</td>
</tr>
<tr>
<td>Copy</td>
<td>Standard clipboard Copy functionality. Copy is enabled or disabled based on your current selection.</td>
</tr>
<tr>
<td>Paste</td>
<td>Standard clipboard Paste functionality. Paste is enabled or disabled based on your current selection.</td>
</tr>
<tr>
<td>Delete</td>
<td>Standard Delete functionality. Delete is enabled or disabled based on your current selection.</td>
</tr>
<tr>
<td>Rename</td>
<td>Allows you to rename the selected object. Rename is enabled when you select one of the following Project tree elements:</td>
</tr>
<tr>
<td></td>
<td>• A SIM table</td>
</tr>
<tr>
<td></td>
<td>• A sequence</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays the properties of the project, including the project name, creation time, time of the last change to the project, and the project storage path. You can also enter an author name and comments for the project.</td>
</tr>
</tbody>
</table>
S7-PLCSIM execute menu commands

The Execute functions are as follows:

<table>
<thead>
<tr>
<th>Menu text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start CPU</td>
<td>Transitions the simulated PLC to RUN mode. The Start CPU button is only enabled when the simulated PLC is in STOP mode.</td>
</tr>
<tr>
<td>Stop CPU</td>
<td>Transitions the simulated PLC to STOP mode. The Stop CPU button is only enabled when the simulated PLC is in RUN mode.</td>
</tr>
</tbody>
</table>

S7-PLCSIM options menu commands

The Options section contains only one command:

<table>
<thead>
<tr>
<th>Menu text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td>Allows you to make changes to the appearance and behavior of the workspace.</td>
</tr>
</tbody>
</table>

Application settings

Application settings allow you to customize the behavior of S7-PLCSIM. For example, you can choose whether or not to display automatically cascading tooltips, or whether to change the default storage location for projects.
A complete list of configurable settings is as follows:

### General settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application settings</td>
<td>User name</td>
<td>When you create a new project, this is the user name that is saved automatically in the project properties. The default is the Windows user name. You can change the name here if you want to do so.</td>
</tr>
<tr>
<td>User interface language</td>
<td></td>
<td>You can change the user interface language here. The default is English.</td>
</tr>
<tr>
<td>Mnemonic</td>
<td></td>
<td>You can specify the mnemonic for programming:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &quot;German&quot; uses the German mnemonics; for example, &quot;E1.0&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &quot;International&quot; uses the international mnemonics; for example, &quot;I1.0&quot;</td>
</tr>
<tr>
<td>Show list of recently used</td>
<td></td>
<td>Use this to change the number of recently used projects listed under &quot;Main Menu &gt; Project&quot;. The default is eight.</td>
</tr>
<tr>
<td>projects</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open cascade automatically</td>
<td></td>
<td>This check box allows you to display or not display expanded (cascading) information for a tooltip. The box is checked as the default. If you clear the check box, you can still use the help system to obtain further information.</td>
</tr>
<tr>
<td>in tooltips</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start view</td>
<td>Project view</td>
<td>Select this option if you want to always start S7-PLCSIM in Project view.</td>
</tr>
<tr>
<td></td>
<td>Compact view</td>
<td>This option is selected by default. S7-PLCSIM starts in Compact view.</td>
</tr>
<tr>
<td>Reset to default</td>
<td>All application settings</td>
<td>Click &quot;Reset to default&quot; to return to original application settings.</td>
</tr>
<tr>
<td></td>
<td>Editor layouts</td>
<td>Click &quot;Reset to default&quot; to return only the SIM table and Sequence editors to their original application settings.</td>
</tr>
<tr>
<td>Storage settings</td>
<td>Recently used storage location</td>
<td>You can select either this option or the &quot;Default storage location&quot; option. If you select the &quot;Recently used storage location&quot; button, any open project will be saved in the location that your last project was saved.</td>
</tr>
<tr>
<td></td>
<td>Default storage location</td>
<td>You can select either this option or the &quot;Recently used storage location&quot; option. If you select &quot;Default storage location&quot;, your project will be saved at the path listed under &quot;Storage location for projects&quot;.</td>
</tr>
<tr>
<td></td>
<td>Storage location for projects:</td>
<td>Enabled when you select &quot;Default storage location&quot;. You can change the storage location by entering the path or browsing to the folder you want to use.</td>
</tr>
<tr>
<td>Cycle time monitoring</td>
<td>Use downloaded maximum cycle time</td>
<td>Select this option to use the maximum cycle time in the project downloaded from STEP 7.</td>
</tr>
<tr>
<td>(Note that changes to cycle time settings are)</td>
<td>Disable scan cycle monitoring</td>
<td>Select this option to prevent a possible cyclic event overflow error from occurring.</td>
</tr>
<tr>
<td></td>
<td>Specify maximum cycle time</td>
<td>To change the maximum cycle time, select this option and then input the new time in the &quot;Maximum cycle time&quot; box.</td>
</tr>
</tbody>
</table>
### S7-PLCSIM tools menu commands

The Tools commands are as follows:

<table>
<thead>
<tr>
<th>Menu text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start recording</td>
<td>Starts recording actions in the SIM table editor or the Addresses section of Device configuration.</td>
</tr>
<tr>
<td>Stop recording</td>
<td>Stops recording actions in the SIM table editor or the Addresses section of Device configuration and then creates a new sequence from the recording in the Project tree.</td>
</tr>
<tr>
<td>Pause recording</td>
<td>Pauses a recording.</td>
</tr>
</tbody>
</table>
### S7-PLCSIM window menu commands

The Window functions allow you to customize the workspace to fit your needs and to switch the application to Compact view.

<table>
<thead>
<tr>
<th>Menu text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close all</td>
<td>Closes all open editor windows.</td>
</tr>
<tr>
<td>Minimize all</td>
<td>Minimizes all open editor windows. The editors are still active and are available by using the icons in the editor frame.</td>
</tr>
<tr>
<td>Compact view</td>
<td>Transitions the application to Compact view. The main S7-PLCSIM view becomes invisible.</td>
</tr>
<tr>
<td>Next editor</td>
<td>Used to switch between open editor windows. The ordering of the open editors is the order in which they were opened. “Next editor” is disabled if only one editor is open.</td>
</tr>
<tr>
<td>Previous editor</td>
<td>Used to switch between open editor windows. The ordering of the open editors is the order in which they were opened. “Previous editor” is disabled if only one editor is open.</td>
</tr>
<tr>
<td>Split editor space vertically</td>
<td>Creates a vertically split work space so that you can view two editor windows concurrently.</td>
</tr>
<tr>
<td>Split editor space horizontally</td>
<td>Creates a horizontally split work space so that you can view two editor windows concurrently.</td>
</tr>
<tr>
<td>Unsplit editor space</td>
<td>Returns a vertically or horizontally split work space to a single editor window.</td>
</tr>
</tbody>
</table>
S7-PLCSIM help menu commands

The Help functions are as follows:

<table>
<thead>
<tr>
<th>Menu text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show help</td>
<td>Opens the help system.</td>
</tr>
<tr>
<td>Service &amp; Support in Internet</td>
<td>Provides a link to the Siemens Industry Online Support website.</td>
</tr>
<tr>
<td>Installed software</td>
<td>Displays information about your installed Siemens software, including version numbers for S7-PLCSIM and the TIA Portal.</td>
</tr>
</tbody>
</table>
6.1.3 The S7-PLCSIM toolbar

6.1.3.1 S7-PLCSIM toolbar

The S7-PLCSIM toolbar provides the same functionality as the main menu, and also provides power on/power off and CPU family selection functionality:

The commands represented by these icons, from left to right on the toolbar, are as follows:

<table>
<thead>
<tr>
<th>Function</th>
<th>Short description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project command buttons</td>
<td>• Create a new project&lt;br&gt;• Open an existing project&lt;br&gt;• Save a project</td>
</tr>
<tr>
<td>Edit command buttons</td>
<td>• Cut&lt;br&gt;• Copy&lt;br&gt;• Paste&lt;br&gt;• Delete</td>
</tr>
<tr>
<td>Power buttons and CPU family selector</td>
<td>• Power the CPU on or off&lt;br&gt;• Select or change CPU family</td>
</tr>
<tr>
<td>Execute command buttons</td>
<td>• Place the CPU in RUN mode&lt;br&gt;• Place the CPU in STOP mode</td>
</tr>
<tr>
<td>Undo and redo command buttons</td>
<td>• Undo the last action&lt;br&gt;• Redo the last undo action</td>
</tr>
<tr>
<td>Record/playback command buttons</td>
<td>• Record&lt;br&gt;• Stop&lt;br&gt;• Pause</td>
</tr>
<tr>
<td>Window command buttons</td>
<td>• Switch to Compact view&lt;br&gt;• Split the screen horizontally&lt;br&gt;• Split the screen vertically</td>
</tr>
<tr>
<td>Switch views button</td>
<td>• Switch to Compact view</td>
</tr>
</tbody>
</table>
6.1.3.2  S7-PLCSIM toolbar objects

S7-PLCSIM toolbar project buttons

The Project actions on the main toolbar are as follows:

From left to right, these actions perform the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New project</td>
<td>Creates a new project. If your current project contains unsaved changes, you are asked to save the project. S7-PLCSIM automatically assigns a name of &quot;Project(n).sim14&quot; to the new project, where (n) is the next numbered project created. The project name can be changed if you want to do so.</td>
</tr>
<tr>
<td>Open project</td>
<td>Allows you to navigate to the project you want to open. If your current project contains unsaved changes, you are asked to save the project.</td>
</tr>
<tr>
<td>Save project</td>
<td>Saves the simulation project as a &quot;.sim14&quot; file using the current path and file name. You cannot save a project during a download from STEP 7.</td>
</tr>
</tbody>
</table>

S7-PLCSIM toolbar editing buttons

The Edit functions on the main toolbar are as follows:

From left to right, these icons perform the following actions:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Standard Windows clipboard Cut functionality for a selected object.</td>
</tr>
<tr>
<td>Copy</td>
<td>Standard Windows clipboard Copy functionality for a selected object.</td>
</tr>
<tr>
<td>Paste</td>
<td>Standard Windows clipboard Paste functionality for a selected object.</td>
</tr>
<tr>
<td>Delete</td>
<td>Standard Windows Delete functionality for a selected object.</td>
</tr>
</tbody>
</table>
**S7-PLCSIM toolbar power buttons and CPU family selector**

The power on/power off button and CPU family selector on the main toolbar are as follows:

From left to right, these objects perform the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power on/power off button</td>
<td>Powers the CPU on and off. The button is green when the power is on and gray when the power is off.</td>
</tr>
<tr>
<td>CPU family selector</td>
<td>Allows you to select the CPU family of the PLC you want to simulate.</td>
</tr>
</tbody>
</table>

**S7-PLCSIM toolbar CPU execution buttons**

The Execute functions available on the main toolbar are as follows:

From left to right, these icons perform the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN</td>
<td>Transitions the simulated PLC to RUN mode when there is an active simulation project.</td>
</tr>
<tr>
<td>STOP</td>
<td>Transitions the simulated PLC to STOP mode when there is an active simulation project.</td>
</tr>
</tbody>
</table>

**Note**

**RUN/STOP indicators**

Under certain conditions, the RUN/STOP indicators in S7-PLCSIM will show incorrect information, or may be incorrectly disabled. When this occurs, use the equivalent controls in STEP 7 to change the mode of the simulated CPU.
S7-PLCSIM toolbar Window buttons

The actions available in the Window section of the main toolbar are as follows:

- Split editor space horizontally: Allows you to view two editor windows concurrently by splitting the workspace horizontally.
- Split editor space vertically: Allows you to view two editor windows concurrently by splitting the workspace vertically.
- Compact view: Switches from Project view to Compact view.

**S7-PLCSIM toolbar record/playback buttons**

The toolbar buttons Record, Stop, and Pause enable you to record and save a series of actions in the SIM table editor or in the Addresses section of Device configuration and then play them back by using a sequence.

- Start recording: Starts recording actions in a SIM table or in the Addresses section of Device configuration.
- Stop recording: Stops recording actions in the SIM table editor or the Addresses section of Device configuration and then creates a new sequence from the recording in the Project tree.
- Pause recording: Pauses a recording.

**S7-PLCSIM toolbar undo and redo buttons**

The toolbar buttons Undo and Redo enable you to undo and redo certain actions.

- Undo: Enables you to undo certain actions.
- Redo: Enables you to redo actions you have previously undone.
6.1.4 Project tree description

The S7-PLCSIM project tree is similar in design and operation to the project tree in STEP 7. The top level folder in the tree represents the project. The project contains the downloaded PLC, the Device configuration, the SIM table(s), and the sequence(s).

![Project tree diagram]

The nodes in the project tree include the following:

**Project[n]**

- **Project folder**: Displays the current name of the simulation project. The default project name is "Project[n]", where [n] is the next incremental number available for name assignment. For example, the default name of your first S7-PLCSIM project is "Project1". The project folder contains the device (downloaded PLC).

**PLC_n [SIM-"CPU"]**

- **PLC folder**: This displays the name of the simulated PLC as configured in STEP 7, as well as the specific PLC.

  PLC_n [SIM-"CPU family"] displays until you perform a download from STEP 7. After a download, the name of the specific PLC you selected displays (for example, "PLC_1 [CPU 1516-3 PN/DP]").

- **Device configuration**: This node displays the Device configuration as downloaded from STEP 7.
SIM tables folder

A project can contain multiple SIM tables. This folder groups the project's SIM tables.

- **Add new SIM table:** Click this node to add a SIM table to your project. S7-PLCSIM creates a new SIM table with a unique default name and displays the new, empty SIM table in the SIM table editor. You can change the table name by right-clicking it and selecting "Rename".

- **SIM table_1:** By default, a new project contains a single SIM table with the default name "SIM table_1" so that you can immediately begin to enter and monitor addresses. You can change a SIM table name by right-clicking it and selecting "Rename".

Sequences folder

This folder contains the project's sequences. A project can contain multiple sequences.

- **Add new sequence:** Click this node to add a sequence to your project. S7-PLCSIM automatically assigns the new sequence a unique default name and displays the new, empty sequence in the sequence editor. You can change the sequence name by right-clicking it and selecting "Rename".

- **Sequence_1:** By default, a new project will contain a single sequence with the name "Sequence_1". You can rename a sequence by right-clicking its name and selecting "Rename".

6.1.5 Application settings

6.1.5.1 Overview of settings

You can set your preferences for working in S7-PLCSIM by selecting Options > Settings from the main menu in Project view. These settings allow you to customize S7-PLCSIM according to your environment and program.

The settings editor includes:

- application settings
- start view
- reset to default
- storage settings
- cycle time settings
6.1.5.2 Application settings

The Application settings enable you to change the default user name, the user interface language, the mnemonic, select the number of projects you have recently worked with, whether or not you would like tooltip cascades to open automatically, and whether to confirm that you want to exit S7-PLCSIM when you are in Compact view with a configured CPU.

6.1.5.3 Start view

Here you can select how you want S7-PLCSIM to launch. You can launch S7-PLCSIM in either Compact view or Project view.

Compact view is the default setting at installation.

6.1.5.4 Reset to default

These options allow you to reset your application settings. These buttons are identical to the buttons provided in the TIA Portal.
6.1.5.5 Storage settings

Here, you can select the storage path for new projects. These buttons are identical to the buttons provided in the TIA Portal.

6.1.5.6 Cycle time settings

S7-PLCSIM provides cycle time options so you can adjust the timing to your specific PC. If you have a slower or older PC, you might want to disable cycle time monitoring, or adjust the maximum cycle time.

Your cycle time setting is communicated to the simulated PLC when you start up S7-PLCSIM. The simulated PLC uses this value throughout simulation operations.

The acceptable cycle time range is 150 ms to 60000 ms (0.15 seconds to 1 minute).

The default setting for cycle time monitoring is “Disable scan cycle monitoring”. The default setting for the maximum cycle time is 150 ms.

6.1.5.7 Undo/redo in application settings

The application settings editor does not support undo/redo. This is also true for the TIA Portal.
6.1.6 Managing the workspace

You can customize the S7-PLCSIM workspace to conform to your preferred work style just as you can with many other Windows applications:

- You can drag the right bar of the Project tree to show more information.

- You can collapse the Project tree by choosing "Collapse" or "Collapse automatically".

- You can resize columns in SIM tables and sequences.

- You can open and close parts of the application by either clicking them in the Project tree or by opening and closing them in the status bar.

- You can split the workspace vertically or horizontally to show two work areas at the same time.

- You can float windows.

You can further customize your workspace by selecting "Options > Settings" from the main menu.

If you split the screen vertically or horizontally, each pane contains either a "pin" icon or an "unpin" icon. Click the "pin" icon to keep one of the panes constant as you view objects in the other pane. For example, if you have several sequences, you can pin one of them to keep it visible while you cycle through other sequences in the unpinned pane. Clicking Ctrl+F6 in an unpinned pane allows you to cycle between sequences (or any other work area you want to view).

If you reposition or resize your editor windows, you can save the new layout by clicking the "Save window settings" button in the upper right corner of each editor.
### Keyboard shortcuts

The following table lists the Windows keyboard shortcuts that you can use in S7-PLCSIM:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>TIA Portal / S7-PLCSIM</th>
<th>MS Windows</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT</td>
<td>X</td>
<td></td>
<td>Activate or inactivate menu bar mode</td>
</tr>
<tr>
<td>ALT+0-9</td>
<td>X</td>
<td>Reserved to enter ASCII code via number pad</td>
<td></td>
</tr>
<tr>
<td>ALT+A-Z</td>
<td>X</td>
<td>Reserved for opening menus</td>
<td></td>
</tr>
<tr>
<td>ALT+CTRL+LEFT</td>
<td>X</td>
<td>Next open editor</td>
<td></td>
</tr>
<tr>
<td>ALT+CTRL+RIGHT</td>
<td>X</td>
<td>Activate the next application</td>
<td></td>
</tr>
<tr>
<td>ALT+F4</td>
<td>X</td>
<td>Close the application</td>
<td></td>
</tr>
<tr>
<td>ALT+F7</td>
<td>X</td>
<td>Toggle between Compact view and Project view</td>
<td></td>
</tr>
<tr>
<td>ALT+PRINT SCREEN</td>
<td>X</td>
<td>Copies an image of the active window onto clipboard</td>
<td></td>
</tr>
<tr>
<td>ALT+SHIFT+A-Z</td>
<td>X</td>
<td>Reserved for opening menu</td>
<td></td>
</tr>
<tr>
<td>ALT+SHIFT+ESC</td>
<td>X</td>
<td>Activate the previous application</td>
<td></td>
</tr>
<tr>
<td>ALT+SHIFT+TAB</td>
<td>X</td>
<td>Switches to the previous application. The user must press and hold down ALT+SHIFT while pressing TAB</td>
<td></td>
</tr>
<tr>
<td>ALT+SPACE BAR</td>
<td>X</td>
<td>Opens the window menu for the application's main window</td>
<td></td>
</tr>
<tr>
<td>ALT+TAB</td>
<td>X</td>
<td>Switches to the next application</td>
<td></td>
</tr>
<tr>
<td>APPLICATION KEY</td>
<td>X</td>
<td>Opens context menu</td>
<td></td>
</tr>
<tr>
<td>CTRL+0</td>
<td>X</td>
<td>Zoom 100%</td>
<td></td>
</tr>
<tr>
<td>CTRL+1</td>
<td>X</td>
<td>Opens/ closes the PNV</td>
<td></td>
</tr>
<tr>
<td>CTRL+A</td>
<td>X</td>
<td>Select all</td>
<td></td>
</tr>
<tr>
<td>CTRL+ALT+DELETE</td>
<td>X</td>
<td>Activate Windows security dialog</td>
<td></td>
</tr>
<tr>
<td>CTRL+ALT+TAB</td>
<td>X</td>
<td>Switches to aero style on Vista</td>
<td></td>
</tr>
<tr>
<td>CTRL+C</td>
<td>X</td>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>CTRL+DOWN</td>
<td>X</td>
<td>Jump down</td>
<td></td>
</tr>
<tr>
<td>CTRL+END</td>
<td>X</td>
<td>Go to the very end</td>
<td></td>
</tr>
<tr>
<td>CTRL+ESC</td>
<td>X</td>
<td>Activates the Start menu</td>
<td></td>
</tr>
<tr>
<td>CTRL+F12</td>
<td>X</td>
<td>Split the editor horizontally</td>
<td></td>
</tr>
<tr>
<td>CTRL+F4</td>
<td>X</td>
<td>Closes the active editor</td>
<td></td>
</tr>
<tr>
<td>CTRL+F6</td>
<td>X</td>
<td>Next open editor</td>
<td></td>
</tr>
<tr>
<td>CTRL+HOME</td>
<td>X</td>
<td>Go to the very beginning</td>
<td></td>
</tr>
<tr>
<td>CTRL+INSERT</td>
<td>X</td>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>CTRL+NUM-</td>
<td>X</td>
<td>Zoom out</td>
<td></td>
</tr>
<tr>
<td>CTRL+NUM+</td>
<td>X</td>
<td>Zoom in</td>
<td></td>
</tr>
<tr>
<td>CTRL+O</td>
<td>X</td>
<td>Open existing project</td>
<td></td>
</tr>
</tbody>
</table>
## Shortcuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>TIA Portal / S7-PLCSIM</th>
<th>MS Windows</th>
<th>Behavior</th>
</tr>
</thead>
</table>
| CTRL+RETURN | X | Multiline text box: Insert line break without confirmation  
Grid editor: Insert row above current |
| CTRL+S | | | Save |
| CTRL+SHIFT+ESC | X | Activate Task Manager |
| CTRL+SHIFT+F4 | X | Close all editors |
| CTRL+SHIFT+F6 | X | Previous open editor |
| CTRL+SHIFT+K | X | Screen keyboard |
| CTRL+SHIFT+RIGHT | X | Increase selection to the right (depends on context) |
| CTRL+SHIFT+S | X | Save as |
| CTRL+SPACE BAR+lasso with the mouse | X | Zoom to selected area - Device configuration |
| CTRL+UP | X | Jump up |
| CTRL+V | X | Paste |
| CTRL+W | X | Close project |
| CTRL+X | X | Cut |
| DELETE | X | Delete |
| DOWN | X | Move down |
| END | X | Go to the end |
| ESC | X | Stop/ cancel the current task or search, close dialog or drop down |
| F1 | X | Starts the application’s help system from most user interface areas |
| F12 | X | Split the editor vertically |
| F2 | X | Rename (PNV, Grid) |
| F4 | X | Open drop-down |
| F6 | X | Switches between basic frames of WB in top-to-bottom order |
| HOME | X | Go to the beginning |
| INSERT | X | Switches between insert mode and overwrite mode |
| LEFT | X | Move left |
| PAGE DOWN | X | Go one page down |
| PAGE UP | X | Go one page up |
| PRINTSCREEN | X | Copies an image of the screen onto the clipboard |
| RIGHT | X | Move right |
| SHIFT+DELETE | X | Cut |
| SHIFT+DOWN | X | Increase selection |
| SHIFT+F1 | X | Starts the application’s help system from most user interface areas |
| SHIFT+F10 | X | Open shortcut menu |
6.2 Using Undo and Redo in Project view

6.2.1 Overview of Undo and Redo

S7-PLCSIM supports undo and redo for many editing actions in the same way as in the TIA Portal.

Use the toolbar button ◀ for undo and the ◁ button for redo.

You can also use the following standard Windows shortcut key combinations:

- undo by using Ctrl+Z
- redo by using Ctrl+Y

The following sections provide details about the user interface areas and actions that support undo/redo, and the actions that specifically do not support undo/redo.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>TIA Portal / S7-PLCSIM</th>
<th>MS Windows</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHIFT+HOME</td>
<td>X</td>
<td></td>
<td>Increase selection</td>
</tr>
<tr>
<td>SHIFT+INSERT</td>
<td>X</td>
<td></td>
<td>Paste</td>
</tr>
<tr>
<td>SHIFT+LEFT</td>
<td>X</td>
<td></td>
<td>Increase selection</td>
</tr>
<tr>
<td>SHIFT+PAGE DOWN</td>
<td>X</td>
<td></td>
<td>Increase selection</td>
</tr>
<tr>
<td>SHIFT+PAGE UP</td>
<td>X</td>
<td></td>
<td>Increase selection</td>
</tr>
<tr>
<td>SHIFT+RETURN</td>
<td>X</td>
<td></td>
<td>Multiline text box: Insert line break without confirmation</td>
</tr>
<tr>
<td>SHIFT+RIGHT</td>
<td>X</td>
<td></td>
<td>Increase selection</td>
</tr>
<tr>
<td>SHIFT+TAB</td>
<td>X</td>
<td></td>
<td>Jump backward</td>
</tr>
<tr>
<td>SHIFT+UP</td>
<td>X</td>
<td></td>
<td>Increase selection</td>
</tr>
<tr>
<td>UP</td>
<td>X</td>
<td></td>
<td>Move up</td>
</tr>
<tr>
<td>WINDOWS KEY</td>
<td>X</td>
<td></td>
<td>Activates start button menu</td>
</tr>
</tbody>
</table>

6.2.2 Clearing the Undo/Redo queue

The following actions clear the undo/redo queue:

- Saving an S7-PLCSIM project
- Closing an S7-PLCSIM project
- Downloading a STEP 7 program

Each project opens with an empty undo queue. The undo options remain disabled until you perform an undoable action.
Each instance of S7-PLCSIM has its own undo/redo queue. When two instances of S7-PLCSIM are open, the two instances are independent, so actions you take in one instance do not affect the other instances.

When S7-PLCSIM is in Project view without an open project, there are no undoable actions. As you make edits that can be undone, those edits are added to the undo queue. The redo option is only available if your last action was an undo.

If you select to undo multiple actions, each of those actions is then listed in the redo queue. However, as soon as you make a new edit (a new undoable action), S7-PLCSIM empties the redo queue and then disables the redo option.

### 6.2.3 Interaction between Undo and Redo

As you make edits that cannot be undone, those edits are added to the undo queue. The “redo” option only becomes available when you select to undo an action. If you select to undo multiple actions, each of those actions is then listed in the redo queue.

However, as soon as you make a new edit (a new undoable action), S7-PLCSIM empties the redo queue and then disables the redo option.

Redo is only available if your last action was an undo.
### 6.2.4 Undo and Redo in the main Project view window

The following table lists the actions in Project view that support undo/redo. The "undo/redo description" column is the text that appears in the drop-down list for the toolbar buttons.

<table>
<thead>
<tr>
<th>User Action</th>
<th>Undo/Redo Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main menu options:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• &quot;Edit &gt; Cut&quot;</td>
<td>Insert &quot;name&quot;</td>
<td>These allow copy/paste of project components (SIM tables and Sequences). The undo-able action is the paste of a new component. This also allows copy/paste of selections in an editor (selected rows). For these, the undo/redo description should match what is defined for these actions in the specific editor.</td>
</tr>
<tr>
<td>• &quot;Edit &gt; Copy&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• &quot;Edit &gt; Paste&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;Related toolbar buttons:&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• &quot;Cut&quot; button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• &quot;Copy&quot; button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• &quot;Paste&quot; button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Related toolbar button:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• &quot;Delete&quot; button</td>
<td>Delete &quot;name&quot;</td>
<td>This supports deleting a project component (SIM table or Sequence). This also supports deleting selections in an editor (selected rows). For these, the undo/redo description should match what is defined for these actions in the specific editor.</td>
</tr>
<tr>
<td>Main menu options:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• &quot;Edit &gt; Delete&quot;</td>
<td>Rename &quot;name&quot;</td>
<td>This allows you to rename a project component (SIM table or Sequence).</td>
</tr>
<tr>
<td>&quot;Related toolbar button:&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• &quot;Delete&quot; button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;Add new SIM table&quot; from project tree</td>
<td>Add new &quot;name&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Add new sequence&quot; from project tree</td>
<td>Add new &quot;name&quot;</td>
<td></td>
</tr>
<tr>
<td>Renaming project component (SIM table or sequence) from project tree</td>
<td>Rename &quot;name&quot;</td>
<td></td>
</tr>
<tr>
<td>Deleting project component from project tree</td>
<td>Delete &quot;name&quot;</td>
<td></td>
</tr>
</tbody>
</table>
The following table lists the actions in Project view that do not support undo/redo.

<table>
<thead>
<tr>
<th>User Action</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>All actions in the main menu “Project” Related toolbar buttons:</td>
<td>Undo/Redo not supported for project actions.</td>
</tr>
<tr>
<td>• &quot;New project&quot; button</td>
<td></td>
</tr>
<tr>
<td>• &quot;Open project&quot; button</td>
<td></td>
</tr>
<tr>
<td>• &quot;Save project&quot; button</td>
<td></td>
</tr>
<tr>
<td>Main menu option:</td>
<td>Switching between Project views is not undoable.</td>
</tr>
<tr>
<td>• &quot;Edit &gt; Open object&quot;</td>
<td></td>
</tr>
<tr>
<td>Main menu options:</td>
<td>These are online actions.</td>
</tr>
<tr>
<td>• &quot;Execute &gt; Start CPU&quot;</td>
<td></td>
</tr>
<tr>
<td>• &quot;Execute &gt; &quot;Stop CPU&quot;</td>
<td></td>
</tr>
<tr>
<td>Related toolbar buttons:</td>
<td></td>
</tr>
<tr>
<td>• &quot;Place CPU in Run mode&quot; button</td>
<td></td>
</tr>
<tr>
<td>• &quot;Place CPU in Stop mode&quot; button</td>
<td></td>
</tr>
<tr>
<td>Main menu:</td>
<td>Recording actions are not undoable.</td>
</tr>
<tr>
<td>• &quot;Tools &gt; Start recording&quot;</td>
<td></td>
</tr>
<tr>
<td>• &quot;Tools &gt; Stop recording&quot;</td>
<td></td>
</tr>
<tr>
<td>• &quot;Tools &gt; Pause recording”</td>
<td></td>
</tr>
<tr>
<td>Related toolbar buttons:</td>
<td></td>
</tr>
<tr>
<td>• &quot;Start recording&quot; button</td>
<td></td>
</tr>
<tr>
<td>• &quot;Stop recording&quot; button</td>
<td></td>
</tr>
<tr>
<td>• &quot;Pause recording” button</td>
<td></td>
</tr>
<tr>
<td>All actions in the main menu:</td>
<td>Window actions are not undoable.</td>
</tr>
<tr>
<td>• &quot;Window&quot;</td>
<td></td>
</tr>
<tr>
<td>Related toolbar buttons:</td>
<td></td>
</tr>
<tr>
<td>• &quot;Switch to Compact view” button</td>
<td></td>
</tr>
<tr>
<td>• &quot;Split editor horizontally...&quot; button</td>
<td></td>
</tr>
<tr>
<td>• &quot;Split editor vertically...” button</td>
<td></td>
</tr>
<tr>
<td>All actions in the main menu &quot;Help&quot;</td>
<td>Switching between SIM table and Sequence editors is not undoable.</td>
</tr>
<tr>
<td>Switching between editors from the project tree or application frame</td>
<td></td>
</tr>
</tbody>
</table>
6.2.5 **Undo and Redo under Project view main menu > Options > Settings**

None of the actions under Main menu > Options > Settings support undo and redo. TIA Portal behaves in the same way.

6.3 **Working with projects**

S7-PLCSIM stores all project data in a unique project folder. Each S7-PLCSIM project stores the following information:

- The hardware configuration as downloaded from STEP 7
- The program as downloaded from STEP 7
- S7-PLCSIM SIM table(s) and sequence(s)

**Creating a project**

To create a new project, go to "Project > New" from the main menu or main toolbar in Project view, or from the toolbar in Compact view.

S7-PLCSIM V14 projects have the file extension ".sim14".

By default, a new project contains one SIM table named "SIM table_1" and one sequence named "Sequence_1". You can rename these tables if you want to do so.

**Naming a project**

S7-PLCSIM automatically creates a unique, generic name for your project, such as "Project23.sim14". You can rename a project as long as the new name is unique.

**Storing a project**

When you create a new project, S7-PLCSIM automatically suggests a storage location for the project. You can view your project's current storage location by right-clicking the project name in the project tree and selecting "Properties".

To change the default project storage location, follow these steps:

1. Go to "Options > Settings" on the main menu.
2. Select the check box for "Default storage location" in the "Storage settings" area.
3. Type the storage path, or browse to it and select it.
4. Click the "OK" button when you are finished.
Opening a project

Select "Project > Open" to open an existing project. You can select a project from the list of recent projects, or browse to the project you want to open.

Note

S7-PLCSIM versions and projects

You can open an S7-PLCSIM V13 SP1 project from S7-PLCSIM V14. When you do so, the project is converted into an S7-PLCSIM V14 project.

You cannot use S7-PLCSIM V13 or S7-PLCSIM V13 SP1 to open an S7-PLCSIM V14 project.

Saving a project

To save your project with its current name and storage location, go to "Project > Save" or "Project > Save as...". You can accept the default name and location, or change either or both before you save.

Note

Saving during a STEP 7 download

You cannot save a project during a download from STEP 7 because "Save" and "Save as..." are disabled until the download completes.

Opening a saved project

Your saved project opens with the same configuration it had when it was saved, including the hardware configuration and STEP 7 program, SIM tables, sequences, and workspace layout.

Deleting a project

To delete a project, select "Project > Delete project" and then select the project you want to delete.

You can also use Windows Explorer to browse to your project’s storage location and delete it from there.

Project properties

To view your project's properties, right-click the project name in the project tree and select "Properties".
The Project properties dialog box displays information about your project as follows:

<table>
<thead>
<tr>
<th>Category</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Name</td>
<td>Current project name.</td>
</tr>
<tr>
<td></td>
<td>Creation time</td>
<td>Date and time the project was created.</td>
</tr>
<tr>
<td></td>
<td>Last change</td>
<td>Date and time the project was last modified.</td>
</tr>
<tr>
<td></td>
<td>Author</td>
<td>Project author. Defaults to your Windows user name.</td>
</tr>
<tr>
<td></td>
<td>Comment</td>
<td>You can add comments for your project here.</td>
</tr>
<tr>
<td>Details</td>
<td>Storage location</td>
<td>Path to your project's storage location.</td>
</tr>
<tr>
<td></td>
<td>Size in KB</td>
<td>Size of your project in kilobytes.</td>
</tr>
</tbody>
</table>

You can edit the "Author" field by typing over the default name.
You can add comments about your project in the "Comment" field if you want to do so.
Information in the other fields cannot be changed.

6.4 Project view: simulation and project states

6.4.1 Simulations and projects are separate actions

As of S7-PLCSIM V14, creating a project and starting a simulation are two distinct actions:

- Open, create, edit, save, or delete a project. You must be in Project view to take these actions.
- Start a simulation. You can start a simulation from either Project view or Compact view.

6.4.2 Overview of project and simulation states

Generally speaking, Project view displays in one the following states:

- No open project and no running simulation
- No open project and a running but unconfigured simulation
- No open project and a configured simulation
- Project is open with no running simulation
- Project is open with a running but unconfigured simulation
- Project is open with a running, configured simulation
6.4.3 No open project and no running simulation

The following screenshot shows Project view when there is neither an open project nor a running simulation:

Only the following options are available in this state:

- Create a new project
  - Note that you do not need to select a "simulation family" when you create a project.
- Open an existing project
  - Note that opening an existing project might or might not start a simulation. If you previously saved the project with a running simulation, then that simulation is restarted. If you saved the project without a running simulation, Project view opens without a running simulation.
- Select a CPU family for simulation and then start a simulation
  - After selecting the CPU family from the main toolbar and then click the power button to launch a simulation.
- Switch to Compact view
6.4.4 No open project and a running but unconfigured simulation

Project view changes very little if you have selected to start a simulation by clicking the power button, but have not yet configured the simulation with a download from the TIA Portal. The power button turns green to indicate a running simulation. The RUN/STOP buttons remain disabled, and there is no IP address displayed.

However, S7-PLCSIM now appears as a target for download from the TIA Portal. You can then download and debug your program and hardware configuration in the TIA Portal.

In this state, the following options are available:

- **Create a new project**
  - Creating a new project when there is a running simulation causes the new project to attach to the already-running simulation.

- **Open an existing project**
  - Opening an existing project does not terminate the running simulation. Your opened project might or might not contain a simulation. If the project you open does not contain a simulation, your existing simulation is closed before the project is opened.

- **Use the power button to terminate the simulation**
  - Switching the power button to the off state terminates the running simulation.

- **Switch to Compact view**
6.4.5 No open project with a configured simulation

After you configure your simulation with a download from the TIA Portal, the Project view displays enabled RUN/STOP buttons.

In this state, the following options are available:

- Create a new project
  - Creating a new project when there is a running simulation causes the new project to attach to the already-running simulation.
- Open an existing project
  - Opening an existing project terminates the running simulation. Your opened project might or might not contain a simulation. If the project you open does not contain a simulation, your existing simulation is closed before the project is opened.
- Use the power button to end the simulation
- Switch to Compact view
6.4.6 Project is open with no running simulation

If you select to create a new project but have not started a simulation, Project view appears as follows:

With an open project, you can create and edit SIM tables and sequences. The project tree shows that there is no running simulation. Project view displays an unconfigured CPU of the currently selected CPU family.

You can start a simulation for this project by selecting the family of the CPU you want to simulate and then clicking the power button on. When you do this, the project and the running simulation are connected.

You can save the S7-PLCSIM project without starting a simulation. When you re-open the project, the Project view appears as it does in the screenshot above.
6.4.7  Project is open with a running but unconfigured simulation

If you have created, or opened a project and started a simulation, the Project view appears as follows:

The Project tree displays the simulation with a default name and type. The power button is green to indicate a running simulation for the current CPU family. The simulation has not been configured by a download from STEP 7. Switching to Device configuration displays an unconfigured CPU for the currently selected family.
6.4.8  Project is open with a running, configured simulation

In this state, there is an open project with a running simulation that has been configured with a download from the TIA Portal. Project view displays in its fully-functional state.

You can see that Project view has gone online. The simulation status displays in the project tree, along with the name and family of the configured CPU.

6.5  Visual feedback regarding online and offline states

S7-PLCSIM indicates an online status in both Compact view when there is an active connection to the simulated PLC. Online status only occurs:

- after a download to S7-PLCSIM from STEP 7
- opening a previously-configured project

S7-PLCSIM is in offline state if there has not been a download from STEP 7. Offline state is indicated by a dark blue color for the title bar in both Compact view and Project view.

When S7-PLCSIM is online in Project view, an animation appears in the lower right corner of the application:
6.6 Working in Device configuration view

6.6.1 Overview of Device configuration view

Device configuration contains two sections:

- Configured hardware
- Addresses

Configured hardware

S7-PLCSIM provides the Device configuration view so you can visualize the hardware configuration you download for your simulation. This view provides a "read-only" view of your hardware.

You cannot make any changes to your hardware in Device configuration. If you want to modify your hardware configuration, you must do so in STEP 7 and then download it to S7-PLCSIM in order to simulate your new hardware configuration.

Addresses

When you select a device in the hardware section, the Addresses section displays entries for each IO channel of the device.

6.6.2 Device configuration user interface

The Device configuration view contains two sections:

1. A Device configuration that displays the hardware that you downloaded from STEP 7.

2. An Addresses section that displays all of the possible addresses for your input and output devices, as well as a subset of the SIM table that allows you to monitor and modify values without switching to the full SIM table editor.
Device configuration

The Device configuration displays the hardware you downloaded from STEP 7. The Device configuration is for display purposes only. You cannot alter the Device configuration in S7-PLCSIM.

Modules that are functioning properly display a green checkmark. Modules with faults display a fault icon. The CPU displays a RUN or STOP icon depending on its state. This is the same display that appears in STEP 7.

Controls

The toolbar in the configured hardware section is similar to the controls in the STEP 7 Device configuration:

- Button to toggle module names
- Button to select zoom in, zoom selection, and zoom out
- Drop-down list box to indicate zoom percentage

Addresses

Device configuration also contains an Addresses section that includes a subset of the SIM table (the Name, Address, Display format, and Monitor/Modify value columns).
6.6.3 Device configuration sections

6.6.3.1 Configured hardware section

Overview of the configured hardware section
Every time a download from STEP 7 completes, the configured hardware section of Device configuration view automatically updates to display the downloaded hardware configuration. The configured hardware section displays device names just as it does in the STEP 7 Device configuration section.

Supported hardware
S7-PLCSIM accepts, without error, download of any supported S7-1200, S7-1500, or ET 200SP Device configuration. However, you might not be able to simulate devices that S7-PLCSIM does not recognize. Unrecognized devices are omitted from the Device configuration view.

Unrecognized hardware
It is possible that your STEP 7 installation might support newer hardware that Device configuration does not recognize. This can occur if STEP 7 has been updated with a hardware support package (HSP).

Hardware installed with an HSP (hardware support package)
If you have installed devices with a hardware support package, it is possible that those devices might not appear in Device configuration.

Undo and Redo in the configured hardware section
The configured hardware section of Device configuration does not support any actions with Undo/Redo. The hardware section of Device configuration is "read-only".

Downloaded central and decentral hardware display
The configured hardware section of Device configuration view displays details of the hardware that you download from the TIA Portal to S7-PLCSIM.

The configured hardware section is designed to display both central and decentral (remote) modules. However, S7-PLCSIM is not able to display the hardware configuration for fail-safe CPUs and fail-safe decentral IO.

Even if S7-PLCSIM is not able to display the hardware configuration for a device, you can manually enter addresses for that device in the Addresses section of Device configuration or in the SIM table.
Features of the Device configuration view

There are no editing options provided in the Device configuration view. The purpose of this view is to provide status and debugging information for your hardware configuration. If you need to edit your hardware configuration, you must do so in the TIA Portal.

Device status indicators

S7-PLCSIM displays icons to indicate the online status of a device. This information is exactly the same as displayed in the TIA Portal STEP 7 Device configuration in online mode.

Displaying tags for IO addresses

S7-PLCSIM learns the tags you have defined for your program after you perform a download. The Device configuration displays tag names of the IO channels of recognized devices in the same manner as in the TIA Portal STEP 7 Device configuration.

Zoom factor

The Device configuration toolbar contains controls for zooming in and out when you view your hardware configuration. These controls function in the same way as in the TIA Portal STEP 7 Device configuration.
6.6.3.2 **Addresses section**

**Overview of the Addresses section**

Device configuration contains a pull-out section that displays an entry for each IO channel for a device you have selected in the hardware configuration section. This Addresses section functions as a subset of the SIM table editor, and allows you to view and set values for IO channels.

You can select and work with the IO channels for one, or multiple, devices in the hardware configuration section:

![Image of Device configuration view with Addresses section]

**Undo and Redo in the Addresses section**

The Addresses section of Device configuration view supports reading and writing data to the IO channels of a selected device. It is not possible to undo or redo these actions.

6.6.4 **Undo and Redo in Device configuration**

S7-PLCSIM provides the Device configuration so that you can visualize the downloaded hardware configuration for the simulation. This provides a "read-only" view of your configured hardware. You cannot edit anything in the configured hardware section of Device configuration, and therefore undo and redo are not relevant.
6.6.5 **Device configuration view before a STEP 7 download**

If you have created or opened a project but not yet performed a download from STEP 7, Device configuration view displays a generic PLC of the default S7-1500 family.

The generic PLC has a label that reads "PLC Powered Off" if the PLC is powered off, and "Unconfigured PLC" if the PLC is powered on.

6.6.6 **Device configuration view after a STEP 7 download**

After you configure your simulation by performing a download from STEP 7, or when you open a project that contains a configured CPU:

- the hardware configuration section of Device configuration view displays the name and model of the downloaded PLC
- the addresses section displays the onboard addresses for the downloaded PLC
6.7 Features common to both SIM table and Sequence editors

6.7.1 Overview of common features

S7-PLCSIM has two grid-based editor views: SIM table and sequence. These two views have many consistent features between them. The following sections describe functions in common with both the SIM table and Sequence editors.

6.7.2 Common clipboard actions

S7-PLCSIM editors support standard clipboard actions (cut/copy/paste) for the following:

- Text within a cell
- Cell contents
- Single rows (entire row selections)
- Multiple rows (where rows are contiguous or not)

You can select clipboard actions in the following ways:

- Using standard Windows shortcut keys:
  - Ctrl+C for copy
  - Ctrl+X for cut
  - Ctrl+V for paste
- Shortcut menu provided in each editor; accessible by right-clicking in the editor
- The "Edit" menu on the main toolbar

Clipboard actions initiated in any of these ways have identical behavior according to standard Windows behavior.

Selecting multiple rows for clipboard actions

S7-PLCSIM supports selecting multiple rows for clipboard actions, generally in the same way that Windows does.

You can select multiple rows in the following ways:

- Left-click on the selection column for a row, then drag the mouse downward or upward to select multiple contiguous rows.
- Click the selection column for a row, then press and hold the Shift key and click another row (above or below the original) to select all the rows between the two clicks.
- To select multiple noncontiguous rows, click the selection column for a row, then press and hold the "Ctrl" key while selecting other rows. All the clicked rows then become part of the selection.
6.7.3 Adding, editing, and deleting rows

The S7-PLCSIM views are designed so that you will always have an "empty row" in which to add new entries to a SIM table or Sequence. S7-PLCSIM supports adding or inserting empty rows at any valid location in the editor.

- Selecting "Add row" causes a new, empty row to be added immediately below the row with current editing focus.
- Selecting "Insert row" causes a new, empty row to be added immediately above the row with current editing focus.
- If you have selected multiple rows and these rows have focus, "Add row" causes the new row to be added below the first selected row and "Insert row" causes the new row to be added above the first selected row. Note that both of these options might not always be available in the sequence editor, due to the special nature of the first and last rows in that editor.

The S7-PLCSIM views also support deleting one or more rows from the editors. Once you have selected the row(s) using any of the methods described above, you can delete the row(s) using the normal keyboard or menu commands.

6.7.4 Applying tags for addresses

After a download from STEP 7, S7-PLCSIM inspects the downloaded program for tag information. It should be noted that if you change tag information in a SIM table, sequence, or Device configuration, these changes do not flow back "upstream" to STEP 7.

Each time a download from STEP 7 occurs, S7-PLCSIM updates tag information that has been changed in STEP 7 since the last download, based on the following rules:

- If an editor row contains only an address and not a name and the updated tag information contains a name for that address, the entry automatically updates to display both the tag name and the address.
- If the editor row contains an undefined tag (which displays as an error) and the updated tag information contains a definition for this tag name, the entry is automatically updated to display the information for this tag, and the error condition will be cleared.
- If the editor row contains a tag name and its associated address, and the updated tag information does not contain a tag for this address, then the address information for the entry is preserved. The tag name you entered is removed.
- If the editor row contains a tag name and its associated address, and the updated tag information contains a different tag name for that address, the tag name is automatically updated.

6.7.5 Auto-completion for tags

To help you enter tag names, S7-PLCSIM supports an "auto completion" mechanism for tag names. Auto-complete examines the text you input and then provides a list of tag names that match the text.
As an example, consider the following tag table defined in STEP 7:

![Tag Table](image)

When you download this project to S7-PLCSIM, S7-PLCSIM learns the tags from the downloaded tag information. You can then use the updated information in a SIM table or a sequence.

As you enter a tag name, auto complete attempts to match the entered text with previously defined tags. For example, if you enter the text "In" in a SIM table or sequence, the following tag choices automatically appear:

![Auto Complete List](image)

You can use the arrow keys to scroll the list, and then the Enter key to make a selection. When you select a tag from the list, the appropriate address and default display format are automatically set for the entry.

Auto complete also works for data blocks and user-defined data types. When you perform a download to S7-PLCSIM, the data block structures and user-defined data types are learned in the same way that tags and addresses are learned. These entries are valid in a SIM table or a sequence, and auto complete functions for these elements.
6.7 Features common to both SIM table and Sequence editors

6.7.6 Common row indicators

6.7.6.1 Overview of the common row indicators

There are several row indicator icons that are common to both the SIM table and sequence editors:

- Errors
- Forced addresses
- Fail-safe modules and the tags associated with them

6.7.6.2 Error indicator

Whenever invalid data exists in an editor; it is marked as an error.

Cells containing invalid data are colored pink, and the row containing invalid data is marked with an error icon.

6.7.6.3 Force indicator

A “force icon” displays for forced addresses that you download from STEP 7. It is the same icon as the one used in STEP 7. The icon displays for both fully- and partially-forced addresses. The icon displays in the following locations:

- SIM table rows that contain a fully- or partially-forced address downloaded from STEP 7.
- Sequence steps that contain a fully- or partially-forced address downloaded from STEP 7. However, if you disable the sequence step, the force icon does not display.
- Device configuration addresses that contain a fully- or partially-forced address downloaded from STEP 7.

6.7.6.4 Fail-safe indicator

In S7-PLCSIM, fail-safe I/O addresses are displayed with the same yellow fail-safe coloring as in the TIA Portal.

This is true wherever fail-safe addresses are used:

- SIM table editor
- Sequence editor
- Addresses section of Device configuration view
6.8 Working in the SIM table editor

6.8.1 SIM table editor description

A SIM table is similar in design to a STEP 7 watch table:

![SIM table](image)

S7-PLCSIM automatically assigns the name "SIM table_[n]" to a new SIM table, where [n] is the next unused number available.

A new project already contains one SIM table named "SIM table_1". Therefore, if you add a new SIM table, it is assigned the name "SIM table_2" by default.

You can rename a SIM table by right-clicking the name and selecting "Rename".

A simulation project can contain one or multiple SIM tables. Each SIM table must have a unique name.

SIM table toolbar

The icons on the SIM table editor toolbar perform the following actions:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Insert row" /></td>
<td>Insert row</td>
<td>Inserts a new, empty row immediately above the current cursor position.</td>
</tr>
<tr>
<td><img src="image" alt="Add row" /></td>
<td>Add row</td>
<td>Inserts a new, empty row immediately below the current cursor position.</td>
</tr>
<tr>
<td><img src="image" alt="Modify all selected values" /></td>
<td>Modify all selected values</td>
<td>Writes values in the &quot;Consistent modify&quot; column for rows that have the check box selected to write those values in consistent, or batch, mode.</td>
</tr>
<tr>
<td><img src="image" alt="Enable/disable modification of non-inputs" /></td>
<td>Enable/disable modification of non-inputs</td>
<td>By default, you can only write updates to inputs. When you click this button, you can also write updates to outputs, memory areas, and data block addresses. This button is only used to indicate an editing option - it is not an online action.</td>
</tr>
<tr>
<td><img src="image" alt="Export to Excel" /></td>
<td>Export to Excel</td>
<td>Exports the contents of a SIM table in Microsoft Excel .xlsx file format.</td>
</tr>
<tr>
<td><img src="image" alt="Import from Excel" /></td>
<td>Import from Excel</td>
<td>Imports the contents of a Microsoft Excel .xlsx file into a SIM table.</td>
</tr>
</tbody>
</table>
### Working in the SIM table editor

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Load project tags</td>
<td>Loads all tags currently downloaded from your STEP 7 project into the open SIM table. This button is disabled if there are no currently downloaded tags.</td>
</tr>
<tr>
<td>🗒️</td>
<td>Save window settings</td>
<td>Saves any changes you have made to the appearance of the SIM table editor, such as column widths. The saved settings also apply to new SIM tables that you create.</td>
</tr>
</tbody>
</table>

**SIM table editor columns**

The following table describes the SIM table editor columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator (no column header)</td>
<td>This column shows information about your SIM table entry.</td>
</tr>
<tr>
<td>🔄</td>
<td>A purple tag icon appears in this column when a valid tag name is entered, or when you enter an address for a valid tag name from your downloaded STEP 7 program. If you have a fail-safe tag, the purple tag displays on a yellow background just as it does in the TIA Portal.</td>
</tr>
<tr>
<td>🗒️</td>
<td>A red &quot;X&quot; appears if there is an error with your entry. An error message will display.</td>
</tr>
<tr>
<td>🇬🇧</td>
<td>A force indicator displays if the address is forced in any way. For example, a partially forced address displays the same force icon in the SIM table as a fully forced address.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the tag name.</td>
</tr>
<tr>
<td>Address</td>
<td>Displays the tag address.</td>
</tr>
<tr>
<td>Display format</td>
<td>Different display formats are available and depend on the type of entry. Some examples include Bool, Hex, and signed decimal (DEC +/-).</td>
</tr>
<tr>
<td>Monitor/Modify value</td>
<td>Displays the entry's current value.</td>
</tr>
<tr>
<td>Bits</td>
<td>A series of check boxes (one box per bit) will display in the field if the address is a bit or byte address. From left to right, the bit order is: 7, 6, 5, 4, 3, 2, 1, 0.</td>
</tr>
<tr>
<td>Consistent modify</td>
<td>This value is written to the PLC when you click the &quot;Modify all selected values&quot; button.</td>
</tr>
<tr>
<td>🗡️</td>
<td>Select the check box in this column if you want the values in the row to be modified when you click the &quot;Modify all selected values&quot; button on the toolbar.</td>
</tr>
<tr>
<td>Comment</td>
<td>You can add a comment here to provide documentation for the SIM table entry.</td>
</tr>
</tbody>
</table>
SIM table editor shortcut menu

When you right-click inside a SIM table, the following shortcut menu displays:

![SIM table editor shortcut menu](image)

6.8.2 Overview of working in the SIM table editor

An S7-PLCSIM SIM table allows you to modify simulated inputs and read simulated outputs. It is similar to a STEP 7 watch table, but the focus is on modifying peripheral inputs and reading peripheral outputs.

A simulation project can contain one or multiple SIM tables. You can run multiple SIM tables concurrently for the same simulated PLC.

Tag name and address display

As soon as you download a program from STEP 7, any open SIM table automatically begins monitoring specified tags and addresses.

Forced addresses

Forced values supersede S7-PLCSIM operations. Be aware that forced values might alter the behavior of your simulation.
6.8.3 **Undo and Redo in the SIM table editor**

The SIM table editor support undo and redo for many actions you perform. However, some actions cannot be undone or redone.

Examples of actions that do not have undo and redo support include:

- Edit text for "Monitor/modify value"
- Clicking the "bits" checkboxes
- Modify all selected values (toolbar button)
- Import from Excel (toolbar button)
- Export to Excel (toolbar button)
- Enable/Disable modification of non-inputs (toolbar button)

Note that additional actions, such as downloading a program from STEP 7, might erase the contents of the undo/redo queue.

6.8.4 **Creating and populating a SIM table**

6.8.4.1 **Overview of creating and populating a SIM table**

You have the following options for adding or inserting rows in a SIM table, or for creating an entire SIM table:

- Use auto fill to create additional rows based on a selected tag or address
- Copy and paste all, or a portion of, a STEP 7 tag table, watch table, or force table
- Drag and drop a module from the hardware configuration section of the S7-PLCSIM Device configuration view
- Import all or a portion of, a STEP 7 tag table, watch table, or force table using Microsoft Excel

6.8.4.2 **SIM table: load project tags from STEP 7**

You can use the "load project tags" button on the SIM table editor toolbar to load your STEP 7 tags into an open SIM table.

Clicking this button loads all of the tags from your most current STEP 7 download.

If there are no tags from the most current download, the "load project tags" button is disabled.

6.8.4.3 **Using auto fill in the SIM table**

You can populate your SIM table by using auto fill. SIM table auto fill works in the same way as in a STEP 7 watch table.

You must have at least one row already entered for auto fill to use as a basis for incrementing addresses. After a download, you can also use auto fill with the "Name" field.
Auto fill procedure

Use the following procedure to auto fill rows in a SIM table:

1. Enter an address in the SIM table "Address" field. A small blue square appears on the bottom right corner of the field.

2. Hover over the blue square. A plus sign ("fill handle") appears. Click and hold the mouse button while you drag straight down to fill the number of addresses you want to add.

3. Tags are added in sequential order according to the selected tag. For example, beginning with "I0.0" as the selected address and auto filling three rows adds I0.1, I0.2, and I0.3.

4. If there are already entries in the cells you select to auto fill, the "AutoFill" dialog displays. Select "Overwrite existing elements" or "Insert elements".

6.8.4.4 SIM table: copy and paste tags and tables from STEP 7

You can copy and paste one tag, several tags, or all tags from a STEP 7 tag table, watch table, or force table to an S7-PLCSIM SIM table.

Before a download, you can copy and paste tag addresses from STEP 7. After a download, you can copy and paste either tag addresses or tag names from STEP 7.

Copying and pasting structured tags

S7-PLCSIM pastes structured tags in a different way. When you copy a structured tag, the cell turns red. Click the cell, add a period to the end of the tag name, and a dropdown list displays all of the tag’s subnodes. You can then select the subnode tags to paste and use in S7-PLCSIM.

When you copy a structured tag, the cell turns red. Click the cell, add a period to the end of the tag name, and a dropdown list displays all of the tag’s subnodes. You can then select the subnode tags to paste and use in S7-PLCSIM.
Copy and paste procedure

Use the following procedure to copy and paste tags from STEP 7 to S7-PLCSIM:

Result: the STEP 7 tags are added to the SIM table.

1. Select one or more tag names, tag addresses, or both in a STEP 7 tag table, watch table, or force table. You can use the Shift key to select sequential tags, or use the Ctrl key to select non-sequential tags.

2. Use Ctrl-C, or right-click and select "Copy" from the shortcut menu.

3. Select a tag name field, tag address field, or both tag name and tag address fields in the SIM table.

4. Use Ctrl-V, or right-click and select "Paste" from the shortcut menu.

Result: the STEP 7 tags are added to the SIM table.

Note

Cut and paste vs. copy and paste

When you perform a cut and paste operation between two open instances of S7-PLCSIM, the data from the source instance is copied instead of being cut.

In order to work around this behavior, delete the cut or copied rows from the source instance.

6.8.4.5 SIM table: import and export using Microsoft Excel

The S7-PLCSIM export button 
allows you to export an existing SIM table in .xlsx format that can then be imported into another SIM table within the same project, or imported into a SIM table in a different project.

The import button 
allows you to create or expand a SIM table by importing an .xlsx file that contains:

- The contents of a different SIM table
- The contents of a STEP 7 tag table, watch table, or force table

Export and import procedure

Export a table from STEP 7 to a Microsoft Excel file:

1. Select tags in a STEP 7 tag table, watch table, or force table. Note that the entire table is exported no matter how many tags you select.

2. Right-click and select "Export" from the shortcut menu.

3. Select a location and name for the exported Excel file.

4. Click "Open".

Result: the entire table is exported with the name and location you entered.
Import a table from a Microsoft Excel file into a SIM table:

1. Open a SIM table.
2. Select the "Import" button from the SIM table toolbar, or select "Import from Excel" from the SIM table shortcut menu.
3. Locate the Excel file you want to import. Note that the import file must be closed for the import to work correctly.
4. Click "Open".

Result: the .xlsx file contents appear in your SIM table.

Note
Imported files with empty address fields
If your .xlsx file contains one or more empty address fields, a warning message displays that the import was only partially successful. An error icon displays in the status indicator column for a row that contains an empty address field.

6.8.4.6 Drag and drop a module from Device configuration to create a SIM table

S7-PLCSIM supports populating a SIM table by dragging a device from Device configuration view and dropping it onto the SIM table. You can facilitate this process by having both Device configuration view and the SIM table editor visible at the same time in project view by clicking the "split window horizontally" button or by floating either editor window:
Here we have the Device configuration view and a SIM table visible at the same time. From
the "Addresses" tab in Device configuration view, you see there are some tags defined for
this device.

You can add SIM table entries for all the IO channels on the device by selecting the device in
the graphical view; dragging it to the SIM table; and then dropping it.

If you select to drag and drop a module onto a SIM table that already contains entries, the
new entries for the module are appended to the end of the SIM table.

After the drag and drop operation, there is no further link between the device and the SIM
table. If changes for the Device configuration are downloaded to S7-PLCSIM (changes to the
address mapping for the module, for example), these changes are not automatically
reflected in the SIM table.

You can also select multiple devices in Device configuration view by holding the Ctrl key and
clicking the modules you want to select). Dragging these multiple devices and dropping them
onto a SIM table will populate the table with the IO address for all the selected devices.

6.8.5 Monitoring and modifying SIM table values

The "Monitor/Modify value" column displays the current value in the format you selected in
the "Display format" column. You can modify values in the SIM table either individually, using
this column, or in a consistent (batch) mode using the "Consistent modify" column.

Be aware that some SIM table values might only update if the virtual PLC is in RUN mode.

Bit and byte value display

If the address is a bit address, one check box appears in the "Bits" column.

If the address is a byte address, eight check boxes (one check box per bit) appear in the
"Bits" column. The order of the bits, from left to right, is: 7, 6, 5, 4, 3, 2, 1, 0.

The following image shows the check boxes for four SIM table rows, two with bit addresses
and two with byte addresses:

Expanding byte addresses

When you enter a byte address, a triangle icon indicates that you can expand the entry.
When you click the triangle icon, the byte address expands to show separate entries for each bit in the byte. The names and addresses for these "expanded" entries are read-only.

**Note**
The SIM table continues to monitor and update even as you enter new values.

### Modifying non-input addresses
By default, you can only write values to inputs. The SIM table editor toolbar button allows you to also write values to outputs, memory, timer, counter, and data block addresses.

### Modifying individual values
Use the "Monitor/modify value" and "Bits" fields to enter a value that writes immediately to the simulated PLC.

To modify a value individually and immediately, simply enter the new value in the "Monitor/modify value" field.

You can use the individual check boxes in the "Bits" field to immediately change the values of individual bits in a byte address. There is one check box per bit. An empty check box indicates a 0, or FALSE, value. A selected check box indicates a 1, or TRUE, value.

### Modifying values in a consistent (batch) mode
You can update multiple values concurrently by entering the new values in the "Consistent modify" fields.

Select the check boxes for the fields you want to modify in the column headed by the "lightning bolt" icon:

A yellow triangle indicates that a value will be applied when you click the "Modify all selected values" button on the toolbar. The button writes data for all the checked entries containing a modified value. If you do not have an active connection to the simulated PLC and click this button, a warning message appears.

### 6.8.6 Creating a new sequence from recorded SIM table editor actions
You can record actions you take in the SIM table editor to create a sequence, and then play back those actions by running the new sequence.
Procedure to create a new sequence from the SIM table editor

Follow these steps to create a new sequence from the SIM table editor:

1. Create a SIM table.
2. Perform a download from STEP 7.
3. Click the "Start recording" button on the main toolbar, or select "Start recording" from the Tools menu.
4. Enter actions in the SIM table section, such as adding and deleting entries, and changing values individually or in consistent (batch) mode.
5. If you want to pause while you are recording your actions, click the "Pause recording" button on the main toolbar, or select "Pause recording" from the Tools menu.
6. To resume recording, click or select "Pause recording" again. When you are finished recording your actions, click the "Stop recording" button on the main toolbar, or select "Stop recording" from the Tools menu.

Result: a new sequence is created from your recorded actions and appears in the Sequences folder with a default name. You can rename the sequence if you prefer to do so.

6.8.7 SIM table error conditions

The SIM table editor recognizes several error conditions. When an entry error occurs, the cell containing the error turns pink, a red "X" icon appears in the indicator column, and S7-PLCSIM does not gather data for that entry. However, all valid entries continue to monitor.

The following error conditions are recognized at the time of entry:

- Address is invalid (for example, syntactically incorrect)
- Address is out of range; that is, the address is too large for the physical memory of the hardware
- The Monitor/Modify value is out of range for the data type

Empty address field in imported file

If an imported Microsoft Excel .xlsx file contains one or more empty address fields, a warning message displays that the import was only partially successful. An error icon displays in the status indicator column for a row that contains an empty address field.
6.9 Working in the Sequence editor

6.9.1 Overview of working in the Sequence editor

The main purpose of a sequence is to simulate an external process interacting with your program. An external process interacts with the PLC through inputs. Any time you enter an input address (%I), it is automatically converted to a peripheral input address (%I:P) to more accurately simulate a signal from a physical wire.

Sequence editor and addresses

You can manipulate any of the following address areas within a sequence:

- Peripheral Inputs (%I:P)
- Outputs (%Q)
- Memory (%M)
- Data block (%DB)
- Timer (%T)
- Counter (%C)

With the sequence editor, you can define a set of timed value changes on inputs, outputs, and memory addresses. The sequence can be used to simulate the behavior of external devices on the running program. This allows you to observe the effect of your program logic and to make any adjustments that might be necessary.

A project can contain multiple sequences, but you can run only one sequence at a time. You might want to create multiple sequences to see the effect of various adjustments to your program logic rather than modifying a single sequence many times.

When you save your project, you save the sequences. You can replay them multiple times to assist in debugging your program.

When a sequence is no longer useful, you can delete it from your project.

A note about forced addresses

Forced values supersede S7-PLCSIM operations. Be aware that forced values might alter the behavior of your simulation.
6.9.2 Sequence editor description

S7-PLCSIM automatically assigns a name of "Sequence_[n]" to a new sequence, where [n] is the next unused number available. For example, the first sequence for your project is given the name "Sequence_1".

You can change the name of a sequence by right-clicking the name and selecting "Rename".

A simulation project can contain one or multiple sequences. Each sequence must have a unique name.

Sequence editor toolbar

The Sequence editor toolbar includes the following functions:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Insert step" /></td>
<td>Inserts a new empty step immediately above the currently selected step.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Add step" /></td>
<td>Inserts a new empty step immediately below the currently selected step.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Enable step" /></td>
<td>Enables a previously disabled step.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Disable step" /></td>
<td>Disables a step so it will be skipped when you run the sequence.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Step time adjustment" /></td>
<td>Adjusts the time for a step.</td>
</tr>
</tbody>
</table>
| ![Start sequence](image6.png) | Plays the sequence from the beginning. The button is only available when the following conditions are true:
  - There are no other sequences currently running.
  - There are no errors in the sequence.
  You can also click this button to resume a paused sequence. |
| ![Stop sequence](image7.png) | Immediately stops a running sequence. |
### Button | Function
--- | ---
Pause sequence | Pauses the sequence at the currently executing step. You must click the “Start sequence” button to resume your paused sequence.
Repeat sequence | Loops your sequence until you manually stop the sequence.
Default interval and time format settings | Allows you to enter a time in milliseconds to increment the time in the “Time” column for newly added rows. The valid range is 0 - 3600000 ms. Use the time format settings to change the time format.
Export to Excel | Exports sequence to Excel format.
Import from Excel | Allows you to select to import either an Excel spreadsheet or a trace measurement file.
Import from trace measurement | Displays the total execution time for a running sequence, as well as the number of repetitions for a repeating sequence.
Execution time | Saves any changes you have made to the appearance of the sequence editor, such as column widths and split windows. The saved settings also apply to new sequences that you create.
Save window settings |
Sequence editor columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator (no column title)</td>
<td>This column displays icons to indicate the following information:</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>Displays the time in hours:minutes:seconds.fractional seconds (00:00:00.00). The maximum time allowed is 23:59:59.95.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the tag name.</td>
</tr>
<tr>
<td>Address</td>
<td>Displays the memory address affected by the step.</td>
</tr>
<tr>
<td>Display format</td>
<td>Different display formats are available and depend on the data type of the tag. For example, some of the available display formats include Bool, Hex, and floating-point number.</td>
</tr>
<tr>
<td>Action</td>
<td>For the first step in the sequence, the only option is &quot;Start sequence&quot;. For the last step in the sequence, you can:</td>
</tr>
<tr>
<td></td>
<td>• Stop the sequence</td>
</tr>
<tr>
<td></td>
<td>• Repeat the sequence</td>
</tr>
<tr>
<td></td>
<td>For action steps, you can select:</td>
</tr>
<tr>
<td></td>
<td>• Set to value</td>
</tr>
<tr>
<td></td>
<td>• Set to frequency (for input bit memory only)</td>
</tr>
<tr>
<td>Action parameter</td>
<td>Action parameters based on the Action column:</td>
</tr>
<tr>
<td></td>
<td>• For &quot;Set to value&quot;, you can enter a numerical value that is compatible with the entry's data type.</td>
</tr>
<tr>
<td></td>
<td>• For &quot;Set to frequency&quot;, you can enter a frequency in Hertz.</td>
</tr>
<tr>
<td>Comment</td>
<td>You can add a comment here to provide documentation for the step.</td>
</tr>
</tbody>
</table>

Sequence editor rows (steps)

Each row in the Sequence editor represents a step in the sequence. The icons in the indicator column indicate the first and last step, which step is executing during playback, and whether a step has an error:

<table>
<thead>
<tr>
<th>Step and related icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start step</td>
<td>This is a fixed row that does not accept entries. It contains a time of &quot;00:00:00.00&quot;. There are two options in the Action column:</td>
</tr>
<tr>
<td></td>
<td>Start immediately</td>
</tr>
<tr>
<td></td>
<td>Trigger condition</td>
</tr>
<tr>
<td></td>
<td>Steps with times between the first step and the last step in the sequence.</td>
</tr>
</tbody>
</table>
**Step and related icon** | **Description**  
---|---  
Stop step | The last step in a sequence. The Action column contains the text "Stop sequence" or "Repeat sequence".  
Currently executing step | Indicates the step that is currently executing. If you set the same execution time for more than one entry, only one of the entries will show the green arrow.  
Error indicator | Indicates that the step contains an error. A message displays information about the error.

**Sequence editor context menu**

Right-click anywhere in a step to display the following context menu:

![Context Menu](image)

The behavior of these context menu commands is the same as the behavior for the toolbar commands.

### 6.9.3 Undo and Redo in the Sequence editor

The Sequence editor supports undo and redo for many actions you perform. However, some actions cannot be undone or redone.

Examples of actions that do not have undo and redo support include:

- Import from Excel (toolbar button)
- Export to Excel (toolbar button)
- Play sequence (from toolbar button or shortcut menu)
- Stop sequence (from toolbar button or shortcut menu)
- Pause sequence (from toolbar button or shortcut menu)
● Sorting columns
● Selecting or deselecting "Repeat sequence" (from toolbar button)
● Edit execution time

Note that additional actions might also erase the contents of the undo/redo queue.

Undo and Redo during sequence playback

Undo and redo are disabled when a sequence is playing or paused. This is true even when the playing sequence does not have the editing focus or when the playing sequence is not visible.

When the playing sequence ends or you explicitly stop it, undo and redo again become enabled. Any editing actions you perform during sequence playback will be visible in the undo queue.

6.9.4 Creating and populating a sequence

6.9.4.1 Overview of creating and populating a sequence

In addition to manually creating sequences and then entering and editing steps, there are several more "automated" methods for performing tasks in the Sequence editor:

● Use auto fill to create additional steps based on a selected address or tag name
● Create a new sequence from recorded SIM table editor actions
● Copy and paste all, or a portion of, a STEP 7 tag table, watch table, or force table
● Import all, or a portion of, a STEP 7 tag table, watch table, or force table using Microsoft Excel
● Import a trace measurement file from STEP 7 to create a sequence

See also

Sequence: using auto fill (Page 108)
Sequence: import and export using Microsoft Excel (Page 109)
Creating a new sequence from recorded SIM table editor actions (Page 100)

6.9.4.2 Working with a sequence created from a SIM table recording

When you open a sequence that was created from actions that you recorded in the SIM table editor, you will see that the times for the sequence steps match the times for the actions you entered in the SIM table editor.

You can use the sequence the way it is, or adjust the times in the "Time" column for individual steps.

To play back a recorded sequence, simply click the "Start sequence" button.
6.9.4.3 Sequence: using auto fill

Using auto fill with a sequence works in a different way than it works in a SIM table. In a sequence, it is more useful to use auto fill to copy the contents of the auto filled cell than to increment that cell. You can then apply different start times to the same address to see the effect on your program.

Before download, you can use the Address field as the starting field for auto fill. After download, you can use either the Name or Address field for auto fill.

Auto fill behavior and the last sequence step

If you have defined a time for the last step in the sequence and auto fill would result in exceeding that time because of the Default interval, S7-PLCSIM automatically adjusts the time for the last step when you perform the auto fill.

Auto fill and the Default interval time

Before auto filling starts, the time in the Default interval is read. The Default interval value is 50 ms, and you cannot have a Default value less than 50 ms. The auto fill process uses this time to increment the time in the auto filled steps. Each auto filled step will have the same time as the field you selected as the basis for auto fill.

See also

Using auto fill in the SIM table (Page 95)

6.9.4.4 Sequence: copy and paste tags and tables from STEP 7

You can copy tags from STEP 7 and paste them into an S7-PLCSIM sequence, but there are differences from the way copy and paste works in a sequence and in a SIM table.

Copy and paste and the default interval time

Regardless of the time in the Default interval, each pasted step will have a time of 50 ms.

You can change the pasted step times to numbers by using auto fill. Manually input your desired starting time for the topmost pasted step, then use the fill handle to adjust the time for as many steps as you want. The times will then increment by the default interval time.
Copying and pasting structured tags

S7-PLCSIM pastes structured tags in a different way from other tags. When you paste a structured tag, the cell turns red in S7-PLCSIM. Click the cell, add a period to the end of the tag name, and a drop-down list displays all of the tag’s subnodes. You can then select the subnode tags to paste and use in S7-PLCSIM.

Note
Cut and paste vs. copy and paste

When you perform a cut and paste operation between two open instances of S7-PLCSIM, the data from the source instance is copied instead of being cut.

In order to work around this behavior, delete the cut or copied rows from the source instance.

6.9.4.5 Sequence: import and export using Microsoft Excel

You can use Microsoft Excel .xlsx files to export from and import to a sequence by using the export and import buttons just as you would for a SIM table, but there are differences from the way export and import work between a SIM table and a sequence.

Editing an exported file

If you edit values, including values, in an exported sequence file directly in Microsoft Excel, and then re-import that a file into S7-PLCSIM, the results might be different than you expect.

You can address this issue in one of two ways:

- To prevent the issue, you can edit the exported Excel file by changing the format of the time and other numerical field(s) to be text fields, and then edit the Excel file.
- You can allow the import to proceed and then manually edit the incorrect values in the sequence editor.

Special considerations for using import and export with a sequence

You can import a .xlsx file into an empty sequence or into a sequence that already contains steps. Make sure that the imported file is not currently open in Excel or the import will fail.

The imported sequence step will be the same time that is present in the time field for the step.

The import operation does not overwrite the first or last step in a sequence because these steps are reserved.

You can export a sequence to populate another sequence in your current project or in another project.

If your .xlsx file contains one or more rows with empty address fields, the rows are imported into the sequence as empty steps.
Special case for import into an existing sequence

If the sequence already contains entries, the imported rows are added at the bottom of the existing entries and before the last step.

If you have defined a time for the last step in the sequence and the import results in exceeding that time, S7-PLCSIM automatically adjusts the stop time to accommodate the imported steps.

Importing watch table entries containing structured tags

S7-PLCSIM handles structured tags in a different way. When you import the contents of a watch table that contains structured tags, the cells containing the structured tags turn red in S7-PLCSIM. Click the cell, add a period to the end of the tag name, and a drop-down list displays all of the tag’s subnodes. You can then select the subnode tags to use in the sequence.

See also

SIM table: import and export using Microsoft Excel (Page 97)

6.9.4.6 Sequence: import from a STEP 7 trace

Overview of creating a sequence from a trace

S7-PLCSIM enables you to create a sequence based on a STEP 7 trace measurement file. You can export a trace from STEP 7 in one of two file formats:

- tag trace recording file format (.ttrec or .ttrecx)
- Excel comma-separated value file format (.csv)

You can then import the exported file into S7-PLCSIM to create a sequence.

Exporting a trace from STEP 7

The file you import is a trace file that was exported from the TIA Portal in one of two formats:

- The TIA Portal trace may be exported as a tag trace recording (*.ttrec or *.ttrecx). This file contains not only the tag information and recorded data for a trace measurement, but also the configuration of the trace itself. Note that S7-PLCSIM ignores the configuration information.

- The TIA Portal trace measurement can also be exported to Microsoft Excel as a .csv (comma-separated value) file. This file contains only the recorded measurement data and the tag information.
Note
Both file types contain tag information for the trace measurement. S7-PLCSIM uses only the address information and not the tag information. The only way to update tag information is to perform a download from STEP 7.

Import a STEP 7 trace to create a sequence
There are two import types available to create a sequence from a STEP 7 trace file:
• import from an Excel file (*.xlsx or *.xls file format)
• import from a trace measurement (*.ttrecx, *.ttrec, or *.csv file format).
Therefore, make sure to select "Import sequence from trace measurement".
S7-PLCSIM uses the standard Windows file dialog for you to select the file for import.
Importing the trace file

You can import a STEP 7 trace to create a sequence from three different locations in the user interface:

- in the project tree, by right-clicking on the Sequences folder:

- from the sequence toolbar Import button dropdown:

- within the sequence grid by right-clicking to display the context menu:

Trace measurement addresses

A TIA Portal trace can be defined to record measurements for many addresses. You might not want to include all trace addresses in your sequence. For example, the trace measurement might include recordings for output addresses (%Q memory). These addresses are not valid for an S7-PLCSIM sequence.

When you have selected the file to import, S7-PLCSIM will inspect the trace measurement and build a list of the recorded addresses. You can then select which of the addresses should be used to generate a sequence. The screenshot below shows how this might be displayed:
Here are the features of the "Import trace measurement" dialog:

- All addresses from the trace measurement are listed in the dialog. A scroll bar is added if there are too many addresses to display on the dialog.

- Tag names are shown for addresses with available tag information. The tag names are taken from the current configuration downloaded to S7-PLCSIM - they do not come from the imported trace measurement. For addresses with no available tag name, the default "----" is displayed.

- By default, all addresses except output addresses are selected for inclusion in the import. Output addresses are enabled in the list, but are not selected by default.

Once you have selected the addresses to include and click "OK", a sequence is generated from the trace measurement.

**Note**

The trace measurement file contains tag information, but S7-PLCSIM uses only the address information and not the tag information.

The only way to update tag information in S7-PLCSIM is to perform a download from STEP 7.

**Details about sequence generation**

The sequence is generated according to the following rules:

- An "initialization step" is generated for each included address. This step is generated from the time of the first sample in the trace file, and sets the address to the value of the address in the first sample in the trace file. There is one initialization step for each included address. To visually distinguish these steps, a comment is generated for each one that says: "Initial step". Note that if you do not want to use initialization, you can edit, disable or delete the steps.

- A sequence step is generated for each change of value in one of the included addresses.

**Note**

Trace measurements are taken at each sample time. No sequence step is generated if the value of the address has not changed since the last sample time.

- The sample time for a trace can be much faster than the minimum increment time between sequence steps. S7-PLCSIM adds a sequence step for each sample in the trace file. If the time difference between two samples in the trace file violates the minimum sequence step increment time, the sequence step displays an error. You must correct all sequence step time errors before you can use the sequence.

- The trace supports triggering the recording based on a tag value. When you select this, the trace also supports recording values before triggering. This means the measurements during this pre-trigger time will have negative time values. The S7-PLCSIM sequence does not support negative times for steps. Therefore, when a measurement has negative times, the time values will be adjusted so that the first measurement time has a value of zero in the sequence. Subsequent step times are converted to positive values.
After the sequence is generated, it becomes an S7-PLCSIM sequence that can be edited and used as usual. There is no further connection to the original TIA Portal trace.

6.9.4.7 Recording a sequence from SIM table actions

Overview

You can create a sequence by recording actions you take in a SIM table. You can use this recording to generate a sequence based on the timing of the actions you record in the SIM table.

Recordable SIM table actions

The following example provides details about recordable SIM table actions, and how the generated sequence will appear when you stop recording.

Since the goal of recording SIM table actions is to create a sequence, the generated sequence will contain a step for every action you take that changes a value over time for each unique address. For example, any change to a value in the "Monitor/Modify value" column is recorded as a new step in the generated sequence at the relative time it occurred.

If you make multiple changes to a value over time, each of those changes becomes a step in the generated sequence.

You will obtain the same result by clicking bit checkboxes to change values in the "Bits" column, or by using the "Consistent modify" column to change a single value or multiple values.

You can also make recordable actions in the "Addresses" section of Device configuration. You can make immediate modifications to addresses belonging to your selected hardware module in this section. When recording is active, any actions you take in the Addresses section of Device configuration are recorded in the same way as if you performed those actions in the SIM table.

S7-PLCSIM rounds the times for sequence actions to the nearest 10 ms, in conformance with minimum sequence step time resolution specifications.

If two actions are less than 50 ms apart, this will lead to errors in the resulting sequence.

Recording your SIM table actions

The SIM table toolbar contains three buttons to support recording and playback:

- "Record" button
- "Stop recording" button
- "Pause recording" button

When you click the "Record" button, S7-PLCSIM begins to record specific actions you take in a SIM table to generate a sequence from those actions.
When you click the "Pause" button, S7-PLCSIM pauses the recording clock and stops recording actions. When "Pause" button is pressed again S7-PLCSIM continues recording (the internal clock is gets started again).

When you click the "Stop" button, S7-PLCSIM generates a new sequence and adds it to your project with a standard system-assigned name, such as "Sequence_3". You can see this new sequence and the name it has been given in the project tree. You can rename the sequence by right-clicking the system-generated name and changing it to whatever you want. This new sequence is populated with all the actions you recorded from the SIM table.

Pausing the recording

Your current recording sessions is suspended when you click the "Pause recording" button on the SIM table toolbar. Clicking this button pauses the internal timer. Any actions you take while the sequence is paused will not be included in your recording.

Clicking the "Pause recording" button one more time will restart the recording process, and the internal timer resumes.

If you click the "Stop recording" button while the recording is paused, the recording session will end.

Ending the recording session

When you have recorded all the actions you want for your sequence, end the recording session by clicking the "Stop recording" button on the SIM table toolbar. A new sequence is generated from your recording, and will contain a step for each action that results from a value change for an address. S7-PLCSIM assigns a time for each step that is relative to the time the action was recorded. Sequences that are generated from a recording will always have a first step with the action set to "Start immediately".

Once the sequence has been generated and added to your project, it will function like any other sequence, and has no special behavior or limitations. You are free to modify or extend the sequence in any way you like.

6.9.5 Methods for starting a sequence

6.9.5.1 Sequence start action

The first row of the sequence defines the start condition for the sequence. There are two options: "Start immediately" and "Trigger condition". You select between these two options by choosing the appropriate action for the start step.

- "Start immediately". When you select this option, the first step of the sequence (the second row in the sequence editor) will immediately become active, and the execution time for the sequence will begin to count.

- "Trigger condition". For this option, you must define a trigger condition that will be evaluated to determine when the sequence executes. When you have defined a trigger for the sequence, and then select to play the sequence, the first step in the sequence will only become active when the trigger condition is satisfied.
Choose between these options by selecting the appropriate "action" for the start step, as shown below:

<table>
<thead>
<tr>
<th>Display format</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bool</td>
<td>Start immediately</td>
</tr>
<tr>
<td>Bool</td>
<td>Trigger condition</td>
</tr>
</tbody>
</table>

The default start action for a new sequence is "Start immediately". When this is the selected start action, there are no other fields to edit. The "Time" field will display 00:00:00.00 (or the equivalent time, based on the selected time format), and cannot be edited. There is no "Action parameter" available when you make this selection.

"Start immediately"

When you select this option, the first step of the sequence (the second row in the sequence editor) will immediately become active, and the execution time for the sequence will begin to count.

"Start immediately" is the default start action. When you select this start action, you do not need to edit any other fields. The "Time" field displays 00:00:00.00 (or the equivalent time, based on your selected time format). It cannot be edited. There is no "action parameter" when you make this selection.

"Trigger condition"

When you select this option, you must define a trigger condition that S7-PLCSIM will evaluate to determine when your sequence begins to execute. When you define a trigger condition and then select to play the sequence, the first sequence step becomes active only when the trigger condition is satisfied.

"Trigger condition" requires additional editing. You must define the start condition under the "Action parameter" column. When you select this option, the "Action parameter" field becomes a drop-down list which displays an editing control dialog box.

The trigger is defined as a specific condition for a single tag (or address). This behavior models the "Trigger condition" function for a STEP 7 trace.

6.9.5.2 Repeating a sequence from the toolbar button

The last step in a sequence is the "Stop sequence" step. The sequence stops executing at the time indicated in this step. Any active "Set to frequency" actions stop and the sequence returns to a stopped, editable state.

However, you might want to repeat the sequence in a looping manner. To do this, click the "repeat sequence" toolbar button at any time, whether the sequence is stopped, paused, or playing. After you click this button, it appears to be visually pressed, which indicates that the sequence is actively repeating.
A sequence that is set to repeat has the following functionality:

- When the running sequence reaches the "Stop sequence" step, any active "Set to frequency" actions are stopped.

- For a sequence that is set to "Start immediately", the first step of the sequence immediately becomes active, and the sequence once again proceeds through the defined steps.

- The time that displays in the "Execution time" field is the time for the current iteration of the sequence, rather than the total cumulative time since the sequence first began executing. The current iteration for the repeating sequence (1…n) appears in parentheses next to the execution time.

You can stop a repeating sequence in the following ways:

- Click the stop button. The sequence stops immediately. Clicking the stop button does not affect the state of the "repeat sequence" button.

- De-select the "repeat sequence" button. This causes the sequence to stop when the time for the "stop sequence" step is reached.

Note that sequence repeat settings are not saved with the sequence in your S7-PLCSIM project.

### 6.9.5.3 Start a sequence with a trigger condition

This screenshot shows the default dialog box for the Action parameter field before you begin to configure the trigger:

![Trigger dialog box](image)

To fully configure the trigger, you must input the following information:

- Input the tag or address to be used for the trigger
- Input the event that will be monitored for the tag
- Input the trigger value for the tag (if required)
To input the tag or address, you can click the "Trigger tag" control to see a list of all tags available in your current configuration:

You can select a tag from the list, or directly edit the field to input a tag. When you have selected a tag for the trigger, the tag name and associated address are displayed.

You can also enter an address into the "Trigger tag" field. If the address has an associated tag, the tag name is displayed in the Action parameter field after the entry is complete. If the address does not have an associated tag, only the address is displayed in the Action parameter field after the entry is complete.

Selecting the tag or address also determines what “events” are available. The screenshot below shows that an input bit address has been selected as the trigger tag. The event field displays the default value “= TRUE”.

Different events are available for different data types. The table below lists the supported event types for different addresses:

<table>
<thead>
<tr>
<th>Address type</th>
<th>Data type</th>
<th>Supported events</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit address (%i0.0)</td>
<td>Bool</td>
<td>= TRUE, = FALSE</td>
</tr>
<tr>
<td>Byte address (%mb0)</td>
<td>SInt / Byte</td>
<td>= value</td>
</tr>
<tr>
<td>Word address (%mw0)</td>
<td>Int / WORD</td>
<td>&lt;&gt; value</td>
</tr>
<tr>
<td>DWord address (%md0)</td>
<td>Dint / DWORD</td>
<td></td>
</tr>
<tr>
<td>DWord address (%md0)</td>
<td>Real</td>
<td>&gt; value, &lt; value</td>
</tr>
</tbody>
</table>
For tag types that support a comparison value, the "Value" field in the dialog box becomes enabled. In the example below, the user has selected a WORD address. The "Value" field is enabled and the user must enter a comparison value.

When the user enters a value, the error indication is removed.

And when the user closes the control by clicking the green check box button, the trigger condition displays in the "Action parameter" field.

The blue "X" button is a cancel button. When you click this button, none of your changes are saved.

When you save the sequence, the trigger condition is also saved. When you reopen the project, the trigger condition is just as it was when you saved the project.

When you export a sequence, the trigger condition is exported along with the sequence. The trigger condition remains active if you re-import a sequence that contains a trigger condition.

### 6.9.5.4 Repeating a sequence configured to trigger from a tag

When you have selected "Repeat sequence" for a sequence that is set to "Trigger condition", the starting condition is evaluated again each time the sequence repeats.

- If the starting condition is satisfied, then the first step of the sequence immediately becomes active, and the sequence proceeds through the defined steps.
- If the starting condition is not satisfied, the sequence pauses until the start condition is satisfied and then proceeds as usual.
6.9.5.5 Visual feedback while running a sequence

Visual feedback in Project view while playing a sequence

S7-PLCSIM provides the following visual feedback while a sequence is actively running:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Running Icon" /></td>
<td>In the project tree, a &quot;running&quot; icon displays next to the sequence that is currently running. If the sequence is paused, a &quot;pause&quot; icon appears in place of the &quot;running&quot; icon. In this way, you can select the correct sequence that you want to stop.</td>
</tr>
<tr>
<td><img src="image" alt="Sequence Playing Icon" /></td>
<td>The &quot;sequence playing&quot; icon appears in the lower right side of the Sequence editor window while the sequence is running.</td>
</tr>
<tr>
<td><img src="image" alt="Step Execution Icon" /></td>
<td>The &quot;step execution&quot; icon moves from step to step in the sequence, indicating which step is executing. If you defined multiple steps to begin at the same time, all of the steps display the green arrow.</td>
</tr>
<tr>
<td><img src="image" alt="Execution Time Icon" /></td>
<td>The execution time is displayed in the Sequence editor toolbar.</td>
</tr>
</tbody>
</table>

Visual feedback after stopping a sequence

You can tell when a sequence has stopped running from the following visual indicators:

- There is no "running" icon next to the sequence name in the Project tree.
- The "sequence playing" icon no longer appears in the lower right corner of the Sequence editor window.
- The "step execution" icon stops on the last step executed.
- The execution time stops and displays the total sequence run time. If the sequence is a repeat sequence, the number of repetitions displays in parentheses.
6.9.6 Sequence actions and action parameters

Each entry, or step, in a sequence represents an action to take on the specified address at the time specified in the "Time" column. The type of action that can be specified depends on the data type of the address.

You can specify an address by tag name in the "Name" field or by address in the "Address" field. A sequence entry's address determines its data type and available actions.

Sequence example using bit address

The following example describes how the address for the step determines available options for a bit address:

- Enter an input bit address either by address or by tag name.
- S7-PLCSIM populates the remaining fields in the sequence row with default values.
- The "Set to value" action is the default action. You have two possible options for the action parameter: FALSE or TRUE.
- If you want the "Set to frequency" action rather than the "Set to value" action, select it using the drop-down list and enter a frequency in Hertz in the "Action parameters" field. The input will pulse at that frequency when you run the sequence.

Sequence action: "Set to value"

"Set to value" is a discrete action. In other words, the value is written only one time to the peripheral input. However, since there is no physical I/O to overwrite this action, the specified input holds its value until another action changes it.

Sequence action: "Set to frequency"

The "Set to frequency" action is only available for input bit memory. For all other address areas, and for all other input address sizes (Byte, Word, DWord), the only available action is "Set to value".

When the action is "Set to frequency", the data writes that generate the pulse continue until you change the action for that address or until the sequence stops. If you have selected "Repeat sequence" for the last step, the data writes continue until you select "Stop sequence".

6.9.7 Time-related Sequence information

6.9.7.1 Sequence time entry

Your sequence entries sort and run based on the contents of the "Time" field. The time displays in the format: hours:minutes:seconds.fractional seconds (00:00:00.00).

If you select the "Time" field and simply enter a number (such as "12", for example), S7-PLCSIM interprets and displays the number as 12 seconds (00:00:12.00). To get hours, minutes, and fractional seconds, you must explicitly enter the time using the proper format.
The maximum time allowed for an entry is 23:59:59.95 (S7-PLCSIM rounds sequence time entries to the nearest 50 milliseconds).

The following table shows examples for time values in your sequence:

<table>
<thead>
<tr>
<th>Value entered</th>
<th>Resulting time value</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>00:00:12.00</td>
</tr>
<tr>
<td>12.2</td>
<td>00:00:12.20</td>
</tr>
<tr>
<td>.02</td>
<td>00:00:00.00</td>
</tr>
<tr>
<td>2:2</td>
<td>00:00:02.20</td>
</tr>
<tr>
<td>12:12.12</td>
<td>00:12:12.12</td>
</tr>
<tr>
<td>Empty</td>
<td>00:00:00.00</td>
</tr>
<tr>
<td></td>
<td>The cell turns pink, an error icon displays, and the text that caused the error displays.</td>
</tr>
</tbody>
</table>

**Order of sequence steps**

You do not need to add steps to the sequence in the order they should be executed. You can enter the steps in any order, and they run based on the times you enter in the "Time" column.

You can sort your steps by time before running the sequence by selecting the "Time" column header.

**Sequence time entry rules**

You can define multiple entries with the same time as long as they are not for the same address. An error occurs if you define multiple actions for the same address with the same time.

**Note**

**Multiple steps with the same time**

If you define multiple actions with the same time for different addresses, no error displays, but there is no way to know which action will execute first until you play the sequence. This could result in different ending values for your addresses.

You can sort on the "Address" column to see the actions based on which input addresses are affected.

**Sequence end times for Stop and Repeat sequences**

The time for the last step of your sequence must be equal to or greater than the time for the last step of your sequence plus 50 ms for both Stop and Repeat sequences.

**Sequence time entry examples**

If you want an input point to pulse at a certain frequency for five seconds and then want the input cleared, the following two sequence examples could be used to accomplish this.
Ending a sequence after five seconds: Example 1

For the first step, choose "Set to frequency" as the action and enter the frequency in Hertz in the "Action Parameters" field.

For the second step, enter a time of 00:00:05.00 in the "Time" field, choose "Set to value" as the action, and enter the value "0" in the "Action Parameters" field.

The pulse generation stops after five seconds.

Ending a sequence after five seconds: Example 2

You can also enter 00:00:05.00 in the Time field for the last step in the Sequence. This also stops the pulse generation after five seconds if you have selected "Stop sequence" in the last step.

6.9.7.2 Sequence step timing

S7-PLCSIM supports timing of sequence steps in two ways:

- You can specify that actions occur at the same time
- You can specify that steps execute sequentially

You can create multiple steps to set the values for several addresses at the same time. This is not an error condition. However, if you create multiple steps to set the value for the same address at the same time, this is an error condition. S7-PLCSIM indicates the error condition by changing the color of the error fields to red.

If the sequence steps contain different times, S7-PLCSIM will still enforce a minimum time of 50 ms between steps. If you enter a time that is less than 50 ms after the time in the previous step, this is an error condition and is indicated as such in the user interface.

To illustrate these rules, consider the following examples:

- Three steps with different addresses are defined to execute at the same time. Since each step acts on a different address, this is not an error.
- Multiple steps are defined to execute at the same time for the same address. This is an address conflict error condition.
- When you manually enter the time for a step, S7-PLCSIM rounds the step time to the nearest 10 ms boundary. You are not prevented from entering a time that is < 50 ms from the previous step in the sequence. For example, if you manually enter a time of, for example, 63 ms in the Time field for a step, S7-PLCSIM rounds 63 ms to 60 ms. This scenario does not create errors. But if you now enter a time of 91 ms for another step and commit the edit, the 91 ms time rounds to the nearest 10 ms (in this case, 90 ms). Since this step is not at least 50 ms higher than the 60 ms step, this causes an error condition for the 90 ms step.
- When you edit step times, the "Stop sequence" step will automatically update to equal the time for the latest step plus 50 ms.
6.9.7.3 **Edit execution time**

When you pause a sequence, the current execution time field becomes enabled so that you can edit the execution time. Editing the current execution time gives you a way to restart the sequence at a different location, either rewinding to a prior step or skipping ahead to a later step.

Here is an example:

Here, the sequence has been paused at a time of 12.82 seconds. No new steps become active while the sequence is paused.

Now, assume you edit the execution time to be 21.5 seconds and then click "Start sequence":

Sequence operation starts at the step corresponding to the new execution time. In this example, the sequence skips the step defined at time 21.0 seconds, and begins operation at the step defined for time 21.50 seconds.

If you edit the execution time so that it is between two steps, clicking Start sequence causes the sequence timer to start and the next step becomes active when its time is reached.

Note that the step that was active when you paused your sequence is a "set to frequency" action. Since this step was active when you paused the sequence and then moved the execution time forward, this step is still active when the sequence is started again.

Here is exactly what happened in the above example:

- When the sequence was paused, the active step was running a "set to frequency" action for %I0.3.
- While the sequence was paused, the execution time was edited to skip the next step in the sequence. This step would have stopped the "set to frequency" action.
- By skipping this step, the set to frequency action for %I0.3 is allowed to remain active.
You can also edit the execution time to replay a portion of the sequence. Here is our original example of a paused sequence:

![Sequence Editor](image)

Now, assume you edit the execution time to be 0.00, click Start sequence and then click Pause sequence at 1.00 second:

![Sequence Editor](image)

The active step has a time of 00.00 seconds, but the action at this step is not taken since the execution time was modified to 1.00. Also notice that the step that was active when you paused the sequence at 12.8 seconds (set to frequency for %I0.3) is no longer active. Since you have set the time to an earlier time, this set to frequency action does not restart when you click Start sequence again.

- If you set the execution time to 00.00 seconds, you will restart the sequence. In the example above, the sequence is configured to start by reaching a condition. Setting the time back to 0.00 seconds causes the starting condition to be evaluated again. Editing the execution time to 00.00 seconds is equivalent to stopping and restarting the sequence.

- You cannot set the time past the time of the last step. If you attempt to do so, S7-PLCSIM will autocorrect the time to the stop/repeat sequence step time. If you choose to repeat the sequence, this has the same effect as restarting the sequence, beginning from the first step.

- When you save your project, the current execution time is not saved along with the project. If you save and close the project, any sequences that were in a paused state are shown as stopped.
6.9.8 Inserting, adding, and deleting sequence steps

When you open a new sequence, it contains three rows, or steps:

- A first step containing the "first step" icon in the indicator column, "00:00:00:00" in the "Time" column, and "Start immediately" in the "Action" column. You cannot edit this step.
- An empty step with "00:00.00:00" in the "Time" column.
- A final step containing the "last step" icon in the indicator column, "00:00.00:05" in the "Time" column, and "Stop sequence" (the default value) in the "Action" column.

You can create the first step in a new sequence by editing the empty row.

Inserting a step

When you insert a step, the new step appears above your currently selected step.

You can insert a step in one of the following ways:

- Click the "Insert step" button on the Sequence editor toolbar
- Right-click anywhere in a step and select "Insert step" from the shortcut menu

Adding a step

When you add a step, the new step appears below your currently selected step. The time for the added step will equal the time for the currently selected step plus the default interval time.

You can add a step in one of the following ways:

- Click the "Add step" button on the Sequence editor toolbar
- Right-click anywhere in a step and select "Add step" from the shortcut menu

Using the default interval

If you want to change the default time for an added step, enter a different value in the "Default interval" text box on the Sequence editor toolbar. The time for the new step will be the time for the selected step plus the default interval time value.

For example, if the time for the current step is "00:00:05.00" and you enter "2000" for the default step interval, your added step will have the time "00:00:07.00".
When you add a new step, the default interval time is added to the time of the selected step and all subsequent added steps.

**Note**

**Effect of the default interval on inserted steps**

The default step interval is only used for added steps. If you insert a step, the time for the inserted step is the time for the currently selected step minus the default interval time value.

The valid range for the default interval is 50 to 5000 ms. Your entry is rounded to the nearest 10 ms.

For example, if you enter "14405" the default interval rounds to "1450".

These are examples of invalid entries that will cause the default interval to revert to its previous value, or to "50" if there is no existing default interval:

- "9999"
- "b"
- "- 100"

**Deleting a step**

To delete a step, select the step you want to delete and perform one of the following actions:

- Click the "Delete" key on your keyboard
- Click the "Delete" toolbar button
- Right-click and select "Delete" from the shortcut menu

**6.9.9 Enable and disable sequence steps**

You can temporarily disable one or more steps in a sequence. Disabled steps are ignored when you play a sequence. This functionality provides you with flexible way to debug your sequence. You can re-enable the disabled step(s) with a single click so that the steps are included the next time you play the sequence.

To disable a step, perform the following actions:

1. select the step by either selecting the entire row, or clicking a cell in the row
2. click the "disable step" button on the Sequence editor toolbar.

You can disable multiple steps at the same time by selecting the steps and then clicking the "Disable step" button.

You can re-enable a step by selecting the step and then clicking the "enable step" button.
Rules regarding disabling and enabling steps

You can disable a step even if it contains an error. In this case the error icon for the row will be replaced by the disabled icon. This allows you to play the sequence and ignore the error.

You can freely edit a disabled step. If you edit the step so that it becomes invalid, the step will not be marked with an error until it is re-enabled. This condition does not prevent you from running the sequence.

You cannot disable either the "Start sequence" step nor the "Stop sequence" step. If you select either of these steps and then click the "Disable step" button, no error is displayed and the step will not be disabled.

The enabled or disabled state of a step is preserved when you copy and paste it.

The enabled or disabled state of a step is preserved when you export a sequence. When you import the sequence again, any disabled steps will be imported in the disabled state.

Sorting the table by time or address will also sort disabled steps.

When you disable a step, this might change the status of another step in the sequence. For example, you might receive an error if there are actions on the same address at the same time. You can remove this type of error from both steps by selecting and disabling one of the steps.

6.9.10 Step time adjustment

When editing and debugging a sequence, you might find that you need to insert a step in the middle of a sequence. As a part of this operation, you might want to delay all the following steps by some amount of time.

To accomplish this, follow this example:

- After testing your sequence, you determine that you need a new step between the existing steps at 02.00 seconds and 02.50 seconds. First use the "Insert step" button to create an empty step at the correct position, then edit the step.

- You want to add a 0.50 second delay to all of the following steps in the sequence. You can do this by manually editing the time for each step, or you can select the steps, right-click and select "Step time adjustment".

- This action allows you to add a positive or negative time to all the selected steps. Selecting this context menu option will display a small dialog box where you can enter an amount of time to add to each step.
  - Adding a positive time increases the "Time" value for each of the steps by that amount.
  - Adding a negative time decreases the "Time" value for each of the steps by that amount. If the decrease would cause any times to become negative, then these step(s) are set to a time of 00.00.

The step time adjustment action does not apply to the start step of the sequence. This step always begins at time zero. If the start step is included with a multiple row selection, there is no change to the start step.

The step time adjustment action does apply to the "stop sequence step". You can edit the time for this step either individually or together with other steps.
The minimum delay (either positive or negative) is 10 ms.
"Step time adjustment" is an action that cannot be undone.
A dialog box with a text entry field is used to indicate the delay time.

6.9.11 Running more than one sequence at a time

You can have multiple sequences in a single project, but you can only run one sequence at a time. When a sequence is running, the "Start sequence" button is not active for any other sequence.

6.9.12 Sequence error conditions

When an error condition exists for a sequence entry, the cell containing the error turns pink and a red "X" icon appears in the indicator column. You can hover over the erroneous entry to display an associated error message.

You cannot play a sequence as long as error conditions exist in the sequence.

The possible errors for a sequence are as follows:

<table>
<thead>
<tr>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undefined tag name</td>
<td>Tag name entered has no match in the download from STEP 7</td>
</tr>
<tr>
<td>Invalid address</td>
<td>Address is syntactically incorrect</td>
</tr>
<tr>
<td>Invalid time</td>
<td>Time is syntactically incorrect</td>
</tr>
<tr>
<td>Invalid Action parameter</td>
<td>Action parameter is syntactically incorrect, or is out of range for the address</td>
</tr>
<tr>
<td>Action parameter out of range for &quot;Set to frequency&quot; value</td>
<td>The valid range is 1 to 100 ms</td>
</tr>
<tr>
<td>Duplicate steps</td>
<td>Two steps are attempting to act on the same address at the same time</td>
</tr>
<tr>
<td>Steps too close together</td>
<td>S7-PLCSIM enforces a minimum 50 ms time difference between any two steps</td>
</tr>
<tr>
<td>Not online</td>
<td>STEP 7 is not online when attempting to run a sequence</td>
</tr>
<tr>
<td>Import only partially successful</td>
<td>One or more missing addresses in a Microsoft Excel file</td>
</tr>
</tbody>
</table>

Note that the Sequence editor does not perform a range check on addresses. It attempts to monitor any address that is syntactically correct.
Working in Project view

6.9 Working in the Sequence editor
7.1 Overview of simulating communication

S7-PLCSIM V14 supports communication between simulation instances. An instance can be an S7-PLCSIM V14 simulation, a WinCC runtime simulation, or an S7-PLCSIM V5.4.7 simulation.

You can run two instances of S7-PLCSIM V14, up to eight instances of S7-PLCSIM V5.4.7, and an even larger number of WinCC runtime simulations, and they can communicate with each other.

How S7-PLCSIM simulates communication

When you launch a simulation, S7-PLCSIM disables external networks and routes communications requests through a communications simulation driver. The driver receives communications requests and routes them to specific simulation instances based on network addresses that S7-PLCSIM assigns and manages.

Communication between simulation instances

All simulation instances must run on the same PC in order to communicate with each other. Each instance must have a unique IP address.

S7-PLCSIM V14 supports TCP/IP and PROFINET connections.

You can simulate communication using GET/PUT and TSEND/TRCV (T-block) instructions for S7-1200 PLCs.

You can simulate GET/PUT, BSEND/BRCV, TSEND/TRCV (T-block), and TSEND_C/TRCV_C (T-Block) instructions for S7-1500 and ET 200SP PLCs.

T-Block instructions and data buffering

S7-PLCSIM V14 implements T-Block instructions without data buffering on the receiving CPU.

The simulated sending CPU’s TSEND instruction does not complete until the program on the simulated receiving CPU executes the TRCV instruction.

Each simulated PLC must have a unique IP address

You cannot run multiple simulations if the PLCs have the same IP address. Each simulated PLC must have a unique IP address.
7.2 Running multiple concurrent simulations

S7-PLCSIM V14 supports two concurrent simulations for any combination of supported CPU types. The simulations must have unique IP addresses for proper communication and functionality. However, there is no restriction from starting a second simulation that has a conflicting IP address with an already-running instance, so you should be aware to avoid this.

You can also run an S7-PLCSIM V14 simulation simultaneously with an S7-PLCSIM V5.x simulation.

When two concurrent simulations are active and you try to start a third, you will receive an error message that the maximum number of instances has been reached, and you will not be able to start a third simulation instance. This will be true when you attempt to start a third concurrent simulation in any of the following ways:

- Launch S7-PLCSIM from the desktop or start menu and then attempt to start a new simulation
- Attempt to launch S7-PLCSIM via the "Start simulation" option in STEP 7
- Double-click on an existing S7-PLCSIM project that has a saved simulation

Remember that with S7-PLCSIM V14 there is a difference between a "simulation" and a "project". You can start a simulation without creating an S7-PLCSIM project. Also, you can create or open an S7-PLCSIM project without launching a simulation. The two-instance limit is enforced for simulations.

You are not prevented from creating a new S7-PLCSIM project when there are already two active simulations. There is no enforced limit on the number of S7-PLCSIM projects that can be open as long as these projects do not also have a running simulations).
7.3 Supported communication instructions between PLC families

The following tables summarize the valid PLC-to-PLC connections by communication instruction and PLC pair:

### GET / PUT

<table>
<thead>
<tr>
<th>CPU #2</th>
<th>S7-300</th>
<th>S7-400</th>
<th>S7-1200</th>
<th>S7-1500</th>
<th>ET 200SP</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-300</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-400</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-1200</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-1500</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### BSEND / BRCV

<table>
<thead>
<tr>
<th>CPU #2</th>
<th>S7-300</th>
<th>S7-400</th>
<th>S7-1200</th>
<th>S7-1500</th>
<th>ET 200SP</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-300</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-400</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-1200</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1500</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### USEND / URCV

<table>
<thead>
<tr>
<th>CPU #2</th>
<th>S7-300</th>
<th>S7-400</th>
<th>S7-1200</th>
<th>S7-1500</th>
<th>ET 200SP</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-300</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-400</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-1200</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1500</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Supported communication instructions between PLC families

#### TSEND / TRCV

<table>
<thead>
<tr>
<th>CPU #1</th>
<th>CPU #2</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-300</td>
<td>S7-300</td>
</tr>
<tr>
<td>S7-400</td>
<td>S7-400</td>
</tr>
<tr>
<td>S7-1200 (SFB 100, 101)</td>
<td>S7-1200 (SFB 100, 101)</td>
</tr>
<tr>
<td>S7-1200 (SFB 150, 151)</td>
<td>S7-1200 (SFB 150, 151)</td>
</tr>
<tr>
<td>S7-1500</td>
<td>S7-1500</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>ET 200SP</td>
</tr>
</tbody>
</table>

#### TUSEND / TURCV

<table>
<thead>
<tr>
<th>CPU #1</th>
<th>CPU #2</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-300</td>
<td>S7-300</td>
</tr>
<tr>
<td>S7-400</td>
<td>S7-400</td>
</tr>
<tr>
<td>S7-1200 (SFB 100, 101)</td>
<td>S7-1200 (SFB 100, 101)</td>
</tr>
<tr>
<td>S7-1200 (SFB 150, 151)</td>
<td>S7-1200 (SFB 150, 151)</td>
</tr>
<tr>
<td>S7-1500</td>
<td>S7-1500</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>ET 200SP</td>
</tr>
</tbody>
</table>

#### TSEND_C / TRCV_C

<table>
<thead>
<tr>
<th>CPU #1</th>
<th>CPU #2</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-300</td>
<td>S7-300</td>
</tr>
<tr>
<td>S7-400</td>
<td>S7-400</td>
</tr>
<tr>
<td>S7-1200</td>
<td>S7-1200</td>
</tr>
<tr>
<td>S7-1500</td>
<td>S7-1500</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>ET 200SP</td>
</tr>
</tbody>
</table>
### 7.3 Supported communication instructions between PLC families

#### TUSEND_C / TURCV_C

<table>
<thead>
<tr>
<th></th>
<th>CPU #1</th>
<th>CPU #2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>S7-300</td>
<td>S7-400</td>
</tr>
<tr>
<td>S7-300</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-400</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1200</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1500</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

#### MODBUS TCP

<table>
<thead>
<tr>
<th></th>
<th>CPU #1</th>
<th>CPU #2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>S7-300</td>
<td>S7-400</td>
</tr>
<tr>
<td>S7-300</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-400</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1200</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1500</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

#### TMAIL

<table>
<thead>
<tr>
<th></th>
<th>CPU #1</th>
<th>CPU #2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>S7-300</td>
<td>S7-400</td>
</tr>
<tr>
<td>S7-300</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-400</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1200</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1500</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

#### TMAIL_C

<table>
<thead>
<tr>
<th></th>
<th>CPU #1</th>
<th>CPU #2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>S7-300</td>
<td>S7-400</td>
</tr>
<tr>
<td>S7-300</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-400</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1200</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1500</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
7.3 Supported communication instructions between PLC families
Error conditions and limitations

8.1 Overview

Specific actions or events might result in errors or unexpected behavior in S7-PLCSIM or in STEP 7. A description of each known issue and any workarounds follows.

8.2 Specific error conditions and limitations

8.2.1 Compile error after attempting to download to S7-PLCSIM

When you attempt to download a STEP 7 program to S7-PLCSIM, you might receive an error that the user program was not compiled and that you should compile the program again.

You might encounter this scenario:
- when you simulate a program that was uploaded from a physical PLC
- when you simulate a program that was copied and pasted into your project

This error is related to automatically generated program blocks such as MC-Servo and MC-Interpolator OBs in motion control programs.

To resolve the error, delete the automatically generated blocks and then compile the program again by using the command "Compile > Software (rebuild all blocks)". This command will correctly recreate and compile the blocks for use in S7-PLCSIM. However, before deleting the blocks, check the settings in your OBs.

Be aware that this error is not limited to motion control. Any program that contains automatically generated blocks might experience the issue. After you remove the automatically generated blocks, your program should compile and download to S7-PLCSIM without further error.

8.2.2 HMI Accessible tags

"HMI Accessible" tags are not available in SIM tables or sequences.

8.2.3 Errors when simulating communication for multiple unconfigured CPUs

You might encounter an error when you run multiple instances of S7-PLCSIM and attempt to simulate communication between multiple unconfigured CPUs. This occurs when each simulation has the same IP address.
Error conditions and limitations

8.2 Specific error conditions and limitations

Example

- Start S7-PLCSIM and launch a simulation for an S7-1500 CPU
- Start a second instance of and launch a simulation for an ET 200SP CPU
- In the TIA Portal, select and attempt to download an ET 200SP CPU to the ET 200SP simulation.

Result: You either receive an "incompatible device" message, or the ET 200SP downloads to the S7-PLCSIM S7-1500 simulation. In this scenario, the first simulator that responds might not be the one you prefer.

Reason: Each simulation responds to all IP addresses while in the unconfigured state.

Solution

Avoid launching more than one unconfigured simulation at a time. If you have more than one open unconfigured simulation, power off or close all but one of them.

8.2.4 "Cut" performs a "Copy" between S7-PLCSIM instances

When you perform a Cut and Paste operation between two open instances of S7-PLCSIM, the data from the source instance is copied instead of being cut.

Description of behavior

Start two instances of S7-PLCSIM and create a simulation project in both instances.

Enter addresses into a SIM table or sequence in one of the instances.

Cut one, or several, of the rows and paste them into a SIM table or sequence in the other instance.

Observe that the cut items are copied instead of being cut, or removed. The cut items appear in the second instance as expected, but remain in the source instance.

Solution

In order to work around this behavior, delete the cut or copied rows from the source instance.

8.2.5 Simulating communication with an HMI and multiple PLCs

If you want to simulate multiple PLCs with an HMI, you might encounter unexpected connection behavior due to the way S7-PLCSIM simulates communication.
You can prevent the problem by starting all PLC simulations before launching your HMI.

**Note**

If you have started your HMI before starting all PLC simulations and then notice unexpected behavior, close and restart the HMI while the PLC simulations remain active.

### 8.2.6 Avoid forcing inputs when simulating S7-1500

Forcing inputs with a simulated S7-1500 or ET 200SP CPU can cause undesired behavior. Instead, use an S7-PLCSIM SIM table to modify input values for these PLCs.

### 8.2.7 Wait briefly after going to RUN mode to access motion control technology objects

The simulated PLC processes motion control commands more slowly than a physical PLC. Because of this difference in processing time, you might encounter an "error" or "busy" state if you attempt to access motion control objects too quickly after going to RUN mode. This is because the objects might not have finished processing completely.

To avoid the situation, wait a brief amount of time to access motion control objects after you put the PLC in RUN mode.

For further details about motion control, see the help section "Differences common to all supported PLCs" > "Simulating motion control".

### 8.2.8 Simulating Fail-safe programs

It is possible that your Fail-safe program might go to STOP unexpectedly. This can occur because of the difference in cycle times between the simulated PLC and a physical PLC.

To correct the situation, increase the F parameter value in STEP 7 by following these steps:

1. In the inspector window, go to "General > Fail safe > F parameter" and set the "Default F monitoring time for central F I/O" to its maximum allowable time (65535 ms).
2. Perform another download from STEP 7 and then run your simulation again.

### 8.2.9 Use STEP 7 safety system library v1.3 or later for Fail-safe I/O

In order to successfully simulate and debug a project that contains Fail-safe I/O, your project must use safety system library v1.3 or later. If your project uses an older version of this system library, your Fail-safe I/O simulation will not function correctly.
8.2.10 Working with global libraries

If your project uses a library, you must compile both hardware and software before performing a download to S7-PLCSIM. If you select only a partial compile, your download will fail.

8.2.11 Valid range for Sequence "Set to frequency" values

By default, S7-PLCSIM V14 supports a "Set to frequency" value for an input bit of 1 to 100 Hz in the Sequence editor "Action" column.

If S7-PLCSIM is not producing a reliable frequency input, run your sequence again after changing the "Set to frequency" value to 16 Hz or lower.

8.2.12 Incorrect RET_VAL parameter values for S7-1500 EN_AIRT and DIS_AIRT instructions that are called from multiple OBs

The extended interrupt instructions EN_AIRT and DIS_AIRT function correctly for S7-1500 projects if they are called from the same OB.

These instructions do not function correctly if they are called from more than one OB. If they are called from more than one OB, the RET_VAL parameter value might not be correct.

8.2.13 Cyclic event overflow error

It is possible to overflow the S7-PLCSIM cyclic event queue when your simulation contains cyclic interrupts. Due to the speed of S7-PLCSIM in relation to actual hardware, it might take longer to create the diagnostic buffer entry than the time until the next cyclic interrupt event.

If this occurs, an additional entry is placed in the queue, which then causes another overflow. S7-PLCSIM provides visual notification of an overflow by means of diagnostic buffer messages and a red error icon in the project tree.

If the queue overflows, go to "Options > Settings > Cycle time monitoring". You can then take one of two actions:

- Select the check box for "Disable scan cycle monitoring".
- Select the check box for "Specify maximum cycle time" and then input a larger value in the "Maximum cycle time" box. You can enter a time up to 60000 ms.

After taking one of these two actions, you must perform another download from STEP 7 for the change to take effect.

8.2.14 Password protection levels and simulation

You cannot configure a PLC protection password in your HMI and then download to S7-PLCSIM.
If you attempt to run a simulation with protection levels set, the HMI receives an error and is unable to connect to S7-PLCSIM. S7-PLCSIM does not check protection levels and therefore indicates that no password is set.

If you have already set protection levels for your PLC, you must remove them before running a simulation. After you are finished with your simulation, you can reset your protection levels.

8.2.15  **STEP 7 online & diagnostics functions**

**STEP 7 online & diagnostics functions**

Certain online & diagnostics functions do not serve a useful purpose for simulation. Using them might cause unexpected behavior in S7-PLCSIM. These include:

- Assign IP address
- Format memory card
- Assign name
- Firmware update

8.2.16  **Simulation during standby mode**

Simulation may stop when your computer or programming device enters "standby" or "sleep" mode. If this happens, communication between STEP 7 and S7-PLCSIM is suspended.

When your computer or programming device becomes active again, it may be necessary to reestablish communication, or in some cases, to reopen your simulation project.

To prevent this situation, disable standby mode for your computer or programming device.

8.2.17  **Running S7-PLCSIM on a remote desktop connection**

It is possible to run S7-PLCSIM by using a remote desktop connection. However, you should avoid disconnecting the connection to the desktop client during configuration. In rare cases, this can lead to the software user interface being blocked.

If you experience user interface blockage, follow these steps on the desktop client:

1. Open the Windows Task Manager and close the "rdpclip.exe" process.
2. Type in "rdpclip.exe" in the command prompt to restart the process.

Note that you will lose the current contents of the clipboard. However, you can then continue configuration as usual.

You should restart S7-PLCSIM as soon as possible.
8.2.18 **Working with automatically synchronized network drives**

Automatic synchronization after a network interruption can result in current (local) project data being stored as a "backup" on the network drive. This could cause outdated project data to be loaded from the network drive when opening the project. For this reason, it is recommended that you do not store S7-PLCSIM projects on synchronized network drives.

If, however, you do work on synchronized drives, you can continue working locally in the event of a network interruption. In this case, you must always ensure that the S7-PLCSIM application is closed while data is synchronized. The synchronization itself must be implemented in such a way that the current (local) project data replaces the project data on the network drive.

8.2.19 **Project menu delay**

You might experience delays, and possibly a crash, when you are opening the project menu if a project in the most recently used projects list is located on a network drive that is not connected.

To correct the problem, reconnect the network drive, or move your projects folder to a connected drive.

8.2.20 **Mnemonics selection**

If you use German mnemonics to create a project and then switch the user interface language, you might experience an error because of the difference in decimal place indicators.

To avoid this problem, use the international mnemonics format (for example, "1.23" rather than "1,23").
Index

A
Access protection, 24
Application settings, 54
Automatic tooltip cascades, 54

C
Communication instruction support
ET 200SP and ET 200SPF, 33
S7-1200, 28
S7-1500, S7-1500C, and S7-1500F, 31
Communications
data buffering, 131
Compact view, 56
CPU name, 47
CPU operator panel, 48
MRES button, 48
overview, 45
title bar, 47
Conflicting actions in a sequence, 129
Copy protection, 24
Customizing the workspace, 61, 66
Cycle time settings, 54

D
Data logging, 24
Device configuration, 62
hardware, 84
Device configuration user interface, 82
addresses section, 83
hardware configuration section, 83
Diagnostic errors, 23
Disabling automatic tooltip cascades, 54
Duplicate addresses in sequence, 129

E
Edit menu, 52
Edit menu commands, 50
Editor bar, 50
Editor windows, 50
Empty address field in imported file, 98, 101
Enabling automatic tooltip cascades, 54
Errors in a sequence, 129
ET 200SP
Counting and measurement technology module, 31
Counting and measurement technology object, 32
fail-safe, 31
firmware, 31
Motion Control technology module, 32
PID Control technology module, 31
PID technology object, 32
ss technology object, 32
supported instructions, 32
technology module support, 31
technology object support, 32
Time-based IO technology module, 32
ET 200SPF
F-monitoring time, 31
supported instructions, 32
Execute menu, 53
Execute menu commands, 50
Execution time, 104
Export a trace
Microsoft Excel .csv file, 110
tag trace recording file, 110

F
Firmware compatibility, 15
Firmware error, 15
Firmware upgrade, 15
Force indicator, 91
Forced address, 94, 102

H
Hardware
in Device configuration, 84
installed with an HSP, 84
unrecognized, 84
Help menu commands, 50
Help system, 57
searching, 35
HMI, 131
HMI Accessible tags, 137
Index

I
I/O device support, 23
Import only partially successful, 98, 101
Import/export
in a sequence, 109
Incompatible data type in sequence, 129
Inserting a step in a sequence, 103
Installed software, 57
Instructions
  BSEND/BRCV, 131
  PUT/GET, 131
  TSEND/TRCV, 131
  USEND/URCV, 131
Invalid address in sequence, 129
IP addresses and communication, 131

K
Keyboard shortcuts, 67
Know-how protection, 23

L
Language settings, 54
LEDs, 24

M
Main menu
  Edit, 52
  Execute, 53
  Help functions, 57
  help system, 57
  Options > Settings, 53
  Project, 51
  window commands, 56
Maximum cycle time, 54
Memory reset, 48
Menu bar, 50
Mnemonic setting, 54
Motion control
  homing mode, 25
  limitations, 25
  technology objects, 25
  TO_ExternalEncoder, 26
  TO_PositioningAxis, 25
MRES, 48
Multiple instances
  copy and paste, 138

N
Naming a project, 73
New features, 11

O
Online support, 34
Options menu commands, 50

P
Password protection, 23
Pasting structured tags, 109
PC-based controller support, 23
Pinning the editor screen, 66
Playing a sequence created from recorded SIM table actions, 107
Power button, 19
PROFINET, 131
Program debugging, 102
Project
  creating a, 73
  data contained in a, 73
  file extension, 59
  location, 54
  new, 59
  open, 59
  properties, 74
  save, 59
Project menu, 51
Project menu commands, 50
Project properties, 50
Project states, 75
Project storage location, 73
Project tree, 50
  Sequences folder, 63
  SIM tables folder, 63
Project view, 49
  toolbar, 58
Project view toolbar
  CPU family selector, 60
  power setting from toolbar, 80
Recent project list, 54
Recipes, 24
Record and playback, 107
Renaming a sequence, 63
Renaming a SIM table, 63
Index

Resetting to default settings, 54
RUN mode, 23
   setting from Execute menu, 53
   setting from toolbar, 60
RUN/STOP, 60

S

S7-1200
   Counting technology module, 28
   fail-safe, 27
   Motion Control technology module, 28
   Motion control technology object, 28
   PID Control technology module, 28
   PID technology object, 28
   supported instructions, 28
   technology module support, 28
   technology object module support, 28
   valid firmware versions, 27
S7-1200F
   F-monitoring time, 27
   supported instructions, 28
   valid firmware versions, 27
S7-1500
   Counting and measurement technology module, 29
   Counting and measurement technology object, 29
   fail-safe, 29
   firmware, 28
   Motion Control technology module, 29
   PID Control technology module, 29
   PID technology object, 29
   ss technology object, 29
   supported instructions, 29
   technology module support, 29
   technology object support, 29
   Time-based IO technology module, 29
S7-1500F
   F-monitoring time, 29
   supported instructions, 29
S7-PLCSIM overview, 11
S7-PLCSIM V14 Advanced, 14
S7-PLCSIM V5.x, 14
Save workspace settings, 66
SD card, 24, 24, 24

Sequence
   action column, 105
   action parameter column, 105
   adding a step, 103
   address column, 105
   adjusting step time, 103
   auto fill, 108
   auto fill and default interval, 108
   comment column, 105
   context menu, 106
   copy and paste, 108
   copy and paste and the default interval, 108
   creating and populating, 107
   creating from a trace file, 110
   current step, 106
   default interval, 104, 108
   disabling a step, 103
   display format column, 105
   editable steps, 105
   enabling a step, 103
   error conditions, 129
   error indicator, 106
   execution time, 104
   export to Excel, 104
   features in common with SIM table, 88
   import from Excel, 104
   import from trace measurement, 104
   import/export, 109
   import/export and the time field, 109
   importing a trace file, 111
   inserting a step, 103
   multiple steps with same address, 122
   name column, 105
   pasting structured tags, 109
   pausing a sequence, 104
   renaming, 103
   repeating a sequence, 104
   running multiple, 129
   save window settings, 104
   start immediately, 105
   start on trigger, 105
   starting a sequence, 103
   steps, 105
   stop step, 106
   stopping a sequence, 103
   time column, 105
   time format settings, 104
   toolbar, 103
   undo and redo, 106
   undo and redo during playback, 107
   visual feedback, 120
   watch table entries, 110

Sequence editor
   actions, 121
   adding a step, 126
   addresses, 102
   default interval, 126
   default steps, 126
   deleting a step, 127

S7-PLCSIM V14 online help
Programming and Operating Manual, V14, 09/2016, A5E38930186-AA